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—
—
—
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Introduction

What is PassageWay Solution?

AT&T PassageWay™ Solution is a collection of software applications that runs
with Microsoft Windows™ operating system version 3.1 or later. These
applications provide you with an interface between your lBM®-compatible
personal computer and a PARTNER® Communications System via your system
or standard telephone. PassageWay Solution increases your
telecommunication capabilities by providing the following applications:

■

■

AT&TBuzz
AT&TBuzz is an application that notifies you of incoming calls and
enables you to view call origination information (referred to as Caller ID
in this document), if available. AT&TBuzz enables you to handle
incoming calls from your PC.

AT&TCall
AT&TCall is a card file application that enables you to maintain names,
addresses, telephone numbers, and other information you desire. With
AT&TCall, you can place calls directly from your PC.
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Introduction

■

■

■

AT&TSet
AT&TSet is an extension programming application that enables you to
program user features and the personal speed dial list for your MLS-
34D®, MLS-18D®, or MLS-12D® telephone from your PC. With AT&TSet,
you can create and save multiple button programming files for your
telephone. You can also exchange these AT&TSet files with other
AT&TSet users. If you are the System Manager, you can use AT&TSet
to perform Centralized Telephone Programming from your PC for any
telephone type and to program the system speed dial list.

Log Viewer
Log Viewer is an application that enables you to access information
from the call log, which stores a record of calls you make using
AT&TCall and receive while AT&TBuzz is running.

AT&TConnect
AT&TConnect is the management software that provides the basis for
the other PassageWay software applications, and the diagnostic
features to troubleshoot these applications. AT&TCall, AT&TSet, and
AT&TBuzz require AT&TConnect to be running to connect these
applications with the PARTNER system, enabling you to fully use these
applications.

PassageWay Solution also provides the following features:

■ autodialing using the Hayes® command set, which is the same
command set used by most modems

■ the ability to use Dynamic Data Exchange (DDE) to link PassageWay
applications with other Windows applications
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Introduction

User Responsibilities

Before using any of the PassageWay applications, you should be familiar with
basic Windows functions and procedures. If not, consult your Microsoft
Windows User's Guide.

You also may need to contact your PC vendor for information on configuring
your PC to meet PassageWay Solution requirements.

Conventions Used in this Guide

The following conventions are used in this guide:

■

■

■

■

■

■

Throughout this guide, telephones are grouped into two different
categories: system telephones and standard telephones. System
telephones refer to AT&T telephones specifically designed to work with
the PARTNER system. These include the MLS-34D, MLS-18D, MLS-
12D, MLS-12®, MLS-6®, and MLC-6 model telephones. Standard
telephones refer to industry-standard single-line rotary or touch-tone
telephones, including feature phones with built-in feature buttons and
lights.

Commands and text you should enter appear in this style of
type.

Values, instructions, and prompts that appear on the screen are in
this style of type.

Key names that are always located on the keyboard in the same place
appear in boxes, as in [ ENTER ↵ ↵ ].

Key combinations (holding down one key while pressing another key)
are connected with hyphens; for example: [ SHIFT ]-[ TAB ➡❘ ].

The terms option buttons and radio buttons refer to the same object.
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Introduction

Getting Help

If you have questions about or problems with the PassageWay applications
that this user's guide does not resolve, call the AT&T National Service
Assistance Center at 1-800-628-2888 or your AT&T Authorized Dealer.
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Installing and Setting Up
PassageWay Solution

Overview

This chapter provides the procedures for installing PassageWay Solution.
Installation of PassageWay Solution consists of the following steps:

1. Installing the PassageWay adapter, which provides an interface between
your PC and telephone

2. Installing the PassageWay software onto the hard disk of your PC

3. Setting up AT&TBuzz

✏

Before installing PassageWay, make sure you have the PassageWay
components and an available serial (COM) port on your PC.

NOTE:
To use the Caller ID capabilities of PassageWay Solution, you must have a
PARTNER II Release 3.0 or later system that has lines subscribed to Caller ID
from your local telephone company. In addition, these lines must be plugged
into a PARTNER 206EC or 400EC module on your PARTNER system.
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Installing and Setting Up PassageWay Solution

PassageWay Components

the PassageWay adapter

The PassageWay adapter provides an interface between your telephone
and an available serial (COM) port on your PC. The PassageWay

PassageWay consists of the following components:

■

■

■

■

■

adapter connects to the Line jack on your telephone.

software (one 3.5-inch, 1.44 MB, high-density diskette). However,
PassageWay Solution is also available on a 5.25-inch, 1.2 MB diskette.
To receive the software on a 5.25-inch diskette, complete the
registration card, specify that you want the software on a 5.25-inch
diskette, and return the registration card.

this user's manual and a quick reference

a 9-pin to 25-pin adapter for 9-pin serial ports

If your PC has a 9-pin serial port, connect the 9-pin to 25-pin adapter to
the serial port. The PassageWay adapter has a 25-pin connector.

a 7-foot, 2-pair, modular phone cord (D4BU)

This modular phone cord connects the PassageWay adapter to your
telephone.

Figure 2-1 shows the PassageWay Solution components.
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Figure 2-1. PassageWay Solution Components
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Figure 2-2 shows the components of the PassageWay adapter.

Figure 2-2. Components of the PassageWay Adapter
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PassageWay Requirements

To use the PassageWay applications, you must have the following
components:

■

■

■

an IBM-PC compatible or PS/2®-compatible PC with the following
hardware:

— an 80286 or higher processor (an 80386 or higher model number
is recommended)

— an available serial port

—

—

—

—

—

a minimum of 2 MB of RAM (4 MB is recommended)

a 3.5-inch, 1.44 MB, high-density drive

a hard disk with 2 MB of space available

a Windows-compatible color video monitor

a Windows-compatible pointing device (a mouse or trackball is
recommended)

Microsoft Windows 3.1 or later release running in standard or enhanced
mode

a system or standard telephone connected to a PARTNER system that
is configured and operating properly. The functionality of the
PassageWay applications depends on the type of telephone you are
using. Any differences in functionality are noted throughout this
document.

NOTE:
If all the serial ports in your PC are already in use, you may wish to purchase

✏
an additional serial port to use with PassageWay Solution. Consult Appendix B
for information on choosing a suitable serial port for PassageWay Solution.
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Before installing the PassageWay software, you must know the following
information:

■

■

the type and release number of the PARTNER system you are using
(for example, PARTNER II Release 3.0). You can obtain this information
from the administrator of your PARTNER system. (The cover of the
Programming and Use manual for your PARTNER system displays the
type and release number of your system.)

the COM port (that is, COM1, COM2, COM3, or COM4) to which you
are connecting the PassageWay adapter.

✏ NOTE:
PassageWay applications can run on a network, but they are not network
aware (that is, PassageWay applications do not support file sharing). If you are
on a local area network (LAN) and have a workstation with a local hard disk,
install the PassageWay software on the local hard disk. If you are on a LAN
and have a workstation that does not have a local hard disk, install the
PassageWay software in your private directory on your fileserver.
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Installing the PassageWay Adapter

The PassageWay adapter provides an interface between the serial port on
your PC and the Line jack on your telephone, enabling you to access the
PARTNER system from your PC. The PassageWay adapter has a DB-25
connector for 25-pin serial ports. If you have a 9-pin serial port on your PC,
use the 9-pin to 25-pin adapter included with PassageWay.

✏ NOTE:
Do not install the PassageWay adapter while you are active on a
call.

To install the PassageWay adapter, perform the following steps:

1. Turn off your PC.

2. Unplug the line cord from your telephone.

3. Connect the line cord to the jack labeled "Line" on the PassageWay
adapter.
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Figure 2-3. Connecting the Line Cord to the PassageWay Adapter
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4. Connect the DB-25 connector on the PassageWay adapter to the serial
(COM) port on your PC. If your PC has a 9-pin serial (COM) port,
connect the 9-pin to 25-pin adapter to the DB-25 connector on the
PassageWay adapter, and then connect the 9-pin to 25-pin adapter to
the 9-pin serial (COM) port.

✏ NOTE:
You can use an RS-232 cable to connect the adapter to the PC if
you do not want to connect the adapter directly to the PC.

5. Connect one end of the 7-foot, 2-pair, modular phone cord (D4BU) to
the jack labeled "Phone" on the PassageWay adapter.
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Figure 2-4. Connecting the Modular Phone Cord to the PassageWay Adapter

6. Connect the other end of the 7-foot, 2-pair, modular phone cord (D4BU)
to the Line jack on your telephone.

7. Turn on your PC.
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Installing the PassageWay Software

The PassageWay software includes an installation program that automatically
installs the PassageWay applications onto the hard disk of your PC. To install
the PassageWay software, perform the following steps:

1. Insert the PassageWay diskette into the diskette drive of your PC.

2 . Access Windows.

3 . From Program Manager, select Run . . . in the File menu.

The Run dialog box appears.

4 . Depending on the diskette drive in which you inserted the PassageWay
diskette, perform one of the following steps:

—

—

If the diskette is in the A: drive, type a:\setup in the Command
Line box and select the OK button.

If the diskette is in the B: drive, type b:\setup in the Command
Line box and select the OK button.

The AT&T PassageWay Setup window appears.
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Welcome to AT&T PassageWay for PARTNER Version 1.0 for
Windows.

This program will install PassageWay for PARTNER on your computer.
Please follow the simple instructions.

You will need to provide the following information during the Setup
procedure:

1. The number of the communications port to which the
PassageWay adapter is connected [e.g., COM1, COM2].

2. The type and release of the PARTNER communications system to
which you are connected [e.g., ARTNER II Release 3.0].

If you do not have this information now, or wish to quit the Setup
procedure at any time, choose Cancel Setup.  Your System Administrator
should be able to provide you with the information needed for the
second item above.

To install PassageWay on your computer, choose the Continue button
or press ENTER.

Figure 2-5. AT&T PassageWay Setup Window

5. Select the Continue button.

The following AT&T PassageWay Setup dialog box appears.
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Figure 2-6. AT&T PassageWay Setup Dialog Box

This dialog box displays the name of the directory in which the
PassageWay applications will reside. If you want to change the default
directory for these applications, specify the directory where you want to
place these applications.

6. Select the Continue button.

The PassageWay applications and their associated files are loaded onto
the hard disk of your PC. A status message box appears, displaying the
status of the software installation.

2-13



Figure 2-7. Sample Installation Status Message Box

After all of the files are loaded, the following message box appears.

Installing and Setting Up PassageWay Solution

Figure 2-8. Setup Complete Message Box

7. Select the OK button.

The AT&T PassageWay Setup window closes, and the COM Port dialog
box appears. The AT&TConnect icon is displayed at the bottom of your
screen.
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Figure 2-9. COM Port Dialog Box

Only available COM ports can be selected; other choices are "grayed."

8. Select the option button of the COM port to which you connected the
PassageWay adapter, and then select the OK button.

The following dialog box appears.

Figure 2-10. AT&TConnect Dialog Box

At this point, you must configure AT&TConnect for your telephone and
PARTNER system. Otherwise, the PassageWay applications will be
unable to operate your telephone.
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9. Select the Continue button.

The AT&TConnect Setup - System Configuration dialog box appears.

Figure 2-11. AT&TConnect Setup - System Configuration Dialog Box

10. Select the option button of your PARTNER system, and then select the
Continue button.

AT&TConnect verifies the connection between the PassageWay adapter
and the COM port you selected, and then "reads" your telephone.

If you do not have a PARTNER II Release 3.0 or later system, the
AT&TConnect Setup - Line Labels dialog box appears when
AT&TConnect finishes reading your telephone (see Figure 2-14). In this
case, proceed to step 13.
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If you have a PARTNER II Release 3.0 or later system, the
AT&TConnect Setup - Caller ID Inspect Feature dialog box appears
when AT&TConnect finishes reading your telephone. If you do not have
a Caller ID Inspect button already programmed on your telephone, the
AT&TConnect Setup - Caller ID Inspect Feature dialog box prompts you
to enter one (Figure 2-12). If you do have a Caller ID Inspect button
already programmed, the AT&TConnect Setup - Caller ID Inspect
Feature dialog box shows where the Caller ID inspect button is
programmed (Figure 2-1 3).

AT&TBuzz requires a Caller ID Inspect button on your phone in order to
provide you with the ability to view Caller ID information for an incoming
call if you are already active on another call.
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Figure 2-12. AT&TConnect Setup - Caller ID Inspect
Feature Dialog Box When No Caller ID Inspect Button
is Programmed
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Figure 2-13. AT&TConnect Setup - Caller ID Inspect
Feature Dialog Box with Caller ID) Inspect Button
Programmed

11. Perform one of the following steps:

■ If a Caller ID Inspect button is not programmed, and you want to
program one, select the button that you want to program as the
Caller ID Inspect button.

"Inspect" appears on the label of the button you selected.

Proceed to step 12.
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■ If a caller ID Inspect button is not programmed, and you do not
want to program one, proceed to step 12.

■ If a Caller ID inspect button is already programmed, proceed to
step 12.

12. Select the Continue button.

The AT&TConnect Setup - Line Labels dialog box appears.

Installing and Setting Up PassageWay Solution

Figure 2-14. AT&TConnect Setup - Line Labels Dialog
Box

AT&TBuzz uses the Line Labels to identify where calls are appearing on
your telephone. You may customize the labels to something that will be
more meaningful to you (for example, the last four digits of the
telephone number of the line assigned to the button or the line number).
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13. Perform one of the following steps:

— If you want to customize the Line Labels, perform the following
steps:

a. Select the label that you want to change.

The AT&TConnect Setup - Edit Line Label dialog box
appears.

b. Enter a new label and select the OK button.

c. Proceed to step 14.

— If you do not want to modify the Line Labels, proceed to step 14.

14. Select the Continue button.

The AT&TConnect Setup - Line Label dialog box closes, and the
AT&TConnect Setup dialog box appears.

Figure 2-15. AT&TConnect Setup
Dialog Box
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This dialog box lists the following information:

■

■

■

the version of your PARTNER system

whether you programmed a Caller ID Inspect button (only if your
system is PARTNER II Release 3.0 or later)

whether or not you customized the line labels

15. Select the OK button.

The AT&TConnect Setup dialog box closes, and the AT&T PassageWay
window appears, displaying the AT&TBuzz, AT&TCall, AT&TConnect,
AT&TSet, and Log Viewer icons. The AT&TConnect icon also appears
at the bottom of your screen.
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Figure 2-16. AT&T PassageWay Window

The installation program puts the AT&TConnect icon in the StartUp group (if
the StartUp group already exists). If the StartUp group does not already exist,
PassageWay Solution creates it and places the AT&TConnect icon in it.

If AT&TConnect is in the StartUp group, every time you invoke Windows the
AT&TConnect software is automatically loaded, and the AT&TConnect icon
appears at the bottom of the screen.

If you do not want AT&TConnect to be loaded automatically every time you
invoke Windows, remove the AT&TConnect icon from the StartUp Group
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window. (See your Microsoft Windows User’s Guide.) However, if you remove
the AT&TConnect icon from the StartUp group window, you must remember to
execute AT&TConnect manually before using other PassageWay applications.
AT&TConnect provides the communication interface between your PC and
your telephone. If AT&TConnect is not running, the other PassageWay
applications on your PC are unable to communicate with your telephone.

Now that the PassageWay software is installed, proceed to "Setting Up
AT&TBuzz."
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Setting Up AT&TBuzz

AT&TBuzz is a software application that enables you to manage incoming calls
(answer, hold, or drop) and view Caller ID (when available) for each incoming
call appearing at your telephone. Unlike AT&TCall and AT&TSet, AT&TBuzz
runs all of the time in the background. When you receive a call, the AT&TBuzz
window appears, notifying you of the call. The AT&TBuzz window displays the
state of all incoming calls that are currently present on your telephone. If you
want AT&TBuzz to be automatically initiated every time that you enter
Windows, add AT&TConnect and AT&TBuzz to your StartUp group.

Before you can start using AT&TBuzz, you must first setup the application.
AT&TBuzz provides several options that enable you to tailor AT&TBuzz to your
needs. Setting up AT&TBuzz consists of the following procedures:

1 . Select the Run Mode option that best suits the way you will use
AT&TBuzz.

2. Set the user options.
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To set up AT&TBuzz initially, perform the following steps:

1. Double-click on the AT&TBuzz icon.

The AT&TBuzz Initialization dialog box appears.

Figure 2-17. AT&TBuzz Initialization Dialog Box

2. Select the Continue button.

The Run Mode dialog box appears.
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Figure 2-18. Run Mode Dialog Box

✏ NOTE:
If you have a PARTNER II Release 3.0 or later system, and no Caller ID
Inspect button is programmed on your telephone, the No Caller ID Inspect
dialog box appears. If you do not want to program a Caller ID Inspect button,
select the Continue button to access the Run Mode dialog box.

A Caller ID Inspect button is important if you want to access the Caller ID
information for outside calls. Without a Caller ID Inspect button, AT&TBuzz will
present Caller ID only for the first call that starts ringing at your telephone.
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However, to use Caller ID, you must have a PARTNER II Release 3.0 or later
system that has lines subscribed to Caller ID from your local telephone
company. In addition, these lines must be plugged into a PARTNER 206EC or
400EC module on your PARTNER system. If your system does not meet these
requirements, it is unnecessary for you to program a Caller ID Inspect button.
If your system does meet these requirements, you should program a Caller ID
Inspect button after setting up AT&TBuzz. (Consult "Programming a Caller ID
Inspect Button" in Chapter 7.)

3. Proceed to "Setting the Run Mode Option."

Setting the Run Mode Option

AT&TBuzz can run in one of the following modes:

■    No Matching

■    Match to AT&TCall File

■    Export via Paste Link DDE

Review the descriptions of all three modes to determine which mode would
best fit your needs.

No Matching Mode

When running in No Matching mode, AT&TBuzz displays on your PC the Line,
State, and Caller ID (if available) for each incoming call. From the AT&TBuzz
window, you can answer, place on hold, or hang up incoming calls. You would
probably use this option if your system does not support Caller ID or if you do
not plan on using the Caller ID information for database look-up. (Only
PARTNER II Release 3.0 or later supports Caller ID.)

To configure AT&TBuzz to run in No Matching mode, perform the following
steps:

1 . Select the No Matching option in the Run Mode dialog box and select
the Continue button.
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A message box states that the initialization process is complete.

2 . Select the OK button.

The AT&TBuzz icon appears at the bottom of your screen.

Figure 2-19. AT&TBuzz Running in No Matching Mode

3 . Proceed to "Setting User Options."
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Match to AT&TCall File Mode

The Match to AT&TCall File mode integrates AT&TBuzz with AT&TCall, giving
you a direct link between the Caller ID of incoming calls and an AT&TCall file.
In this mode, you associate AT&TBuzz with an AT&TCall file. When you
receive an incoming call, AT&TBuzz automatically searches the telephone
numbers on every card in the AT&TCall file. If the Caller ID from the incoming
call matches a telephone number in one of the cards in the AT&TCall file,
AT&TBuzz displays the text from the primary and secondary sort fields from
the card as the Call Label for the call. This gives you the ability to know the
identity of the caller before answering the call. For example, if the primary sort
field is Last Name, and the secondary sort field is First Name in the associated
AT&TCall file, AT&TBuzz displays Last Name, First Name for the Call Label. If
a match is found, you can have AT&TCall display the associated card. If a
match is not found, you can create a new card for this call and add the new
card to the card bank of the associated AT&TCall file.

In this mode, AT&TBuzz displays on your PC the Line, State, Caller ID (if
available), and Call Label (if available) for each incoming call. From the
AT&TBuzz window, you can answer, place on hold, or hang up incoming calls.
You should use this option if your system supports Caller ID, and you want to
match the Caller ID to an AT&TCall file. (Only PARTNER II Release 3.0 or
later supports Caller ID.)

To configure AT&TBuzz to run in Match to AT&TCall File mode, perform the
following steps:

1. Select the Match to AT&TCall File option in the Run Mode dialog box.

2. Click the mouse in the AT&TCall File box and type sample.dex.

This associates AT&TBuzz with the sample AT&TCall file that was
copied to the hard disk of your PC when you installed the PassageWay
applications. After you finish setting up AT&TBuzz, you must run
AT&TCall, create a new AT&TCall file, and then associate your new
AT&TCall file with AT&TBuzz. Refer to Chapter 4 to run AT&TCall and
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create a new AT&TCall file. Refer to Chapter 3 to associate a new
AT&TCall file with AT&TBuzz.

3 . Select the Continue button.

The Area Code dialog box appears.

Figure 2-20. Area Code Dialog Box

4. Enter the area code for the local area and select the OK button.

AT&TBuzz displays a message box indicating that the initialization
process is complete.

5 . Select the OK button.

The AT&TBuzz icon and the icon for the associated AT&TCall file
appear.
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Figure 2-21. AT&TBuzz Running in Match to AT&TCall File Mode

6 . Proceed to "Setting User Options."

Export via Paste Link DDE Mode

The Export via Paste Link DDE mode enables AT&TBuzz to export the Caller
ID and the line label to another Windows application that supports Paste Link
DDE. In turn, AT&TBuzz may receive a string from that other Windows
application and use that string as a Call Label.
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To use this option, you must meet the following requirements:

■ The application that receives the Caller ID must support paste link DDE.

■ You must have a user-customized interface in the application that
receives the Caller ID. Examples are provided in the Readme file for
AT&TBuzz.

■ Your PARTNER system must support Caller ID.

For more information on Export via Paste Link DDE mode, refer to
Appendix C.

✏

To configure AT&TBuzz to run in Export via Paste Link DDE mode, perform
the following steps:

NOTE:
When you configure AT&TBuzz to run in Export via Paste Link
DDE mode, the contents of the Windows clipboard are
overwritten. Therefore, if you have information in the clipboard
that you want to save, go to another application and paste this
information into a file before initializing AT&TBuzz to run in Export
via Paste Link DDE mode. However, this only occurs when you
first configure AT&TBuzz to run in Export via Paste Link DDE
mode or select the Initialize Paste Link DDE option from the File
menu. The contents of the clipboard are not affected during
operation.

1. Select the Export via Paste Link DDE option in the Run Mode dialog
box and select the Continue button.

AT&TBuzz displays a dialog box indicating that the initialization process
is complete.

2 . Select the OK button.

The following dialog box appears.
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Figure 2-22. AT&TBuzz Initialization Dialog Box

3 . Select the Yes button.

The following message box appears.

Figure 2-23. AT&TBuzz Information Dialog Box

4 . Select the OK button.

The AT&TBuzz icon appears at the bottom of your screen.
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Figure 2-24. AT&TBuzz Running in Export via Paste Link DDE Mode

5 . Proceed to "Setting User Options."
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Setting User Options

The AT&TBuzz user options enable you to further tailor AT&TBuzz to your
needs. You can set the following user options:

■

■

■

Show AT&TBuzz on Ringing
You can set the AT&TBuzz window to appear automatically when a call
rings at your telephone. However, if you do not want to be distracted by
this window "popping up" every time your phone rings, you can set the
AT&TBuzz window to be opened manually (that is, you must double-
click on the AT&TBuzz icon when you want to access the AT&TBuzz
window and answer a call). By defaut the AT&TBuzz window appears
automatically when a call rings at your telephone.

Show AT&TCall Card
If you are running AT&TBuzz in Match to AT&TCall File mode, you can
set whether you want AT&TBuzz to show automatically the card that is
associated with an incoming call. By default, you must select the Show
Card button in the AT&TBuzz window to view the associated card. If you
want AT&TBuzz to automatically show the associated card, you may
specify whether you want the card displayed when the call rings at your
telephone, or when you answer the call.

Automatic Inspect Mode
You can specify whether you want AT&TBuzz to automatically inspect
every incoming call that rings at your telephone. In Automatic Inspect
mode, AT&TBuzz provides the Caller ID automatically for every
incoming call (if available). By default, Automatic Inspect Mode is
disabled.

✏ NOTE:
If you enable Automatic Inspect Mode, you should always answer
calls from AT&TBuzz, instead of answering calls directly from the
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telephone. This prevents you from interrupting an "inspection" in
progress and answering a call other than the one you are
expecting to answer.

■

■

Call Logging
AT&TBuzz enables you to turn call logging on or off for incoming calls. if
you turn on call logging, you have the option of logging all incoming
calls (that is, calls that were answered and calls that were unanswered)
or only those calls that were answered. Unanswered calls include those
calls that were answered at another extension or by voice mail. By
default, AT&TBuzz logs all incoming calls.

Answering Second Call
AT&TBuzz enables you to specify what should be done automatically y to
an active (incoming) call when you attempt to answer another call. By
default, AT&TBuzz prompts you to specify what should be done with the
active call every time you attempt to answer another call. You can set
AT&TBuzz to either automatically place the active call on hold or drop
the active call when you attempt to answer another call. For example, if
you know that you always want to place the active call on hold and
answer the next call, select Auto-Hold First Call. You may want to keep
the default setting to determine whether you want to automate this
process.

If you are active on an outgoing call and you attempt to answer a
second call, AT&TBuzz will always prompt you to place the active call
on hold. This operation is not affected by the Answering Second Call
option.

Local Area Code
When running in Match to AT&TCall File mode, AT&TBuzz requires your
local area code.

■
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To set the user options, perform the following steps:

1. Double-click on the AT&TBuzz icon to open the AT&TBuzz window.

The AT&TBuzz window appears.

2. Select Options. . . from the Setup menu.

The Options dialog box appears. The contents of the Options dialog box
depend on whether you are running AT&TBuzz in Match to AT&TCall
File mode.

Figure 2-25. Options Dialog Box when AT&TBuzz is
Running in Match to AT&TCall File Mode
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Figure 2-26. Options Dialog Box when AT&TBuzz
is Running in No Matching or Export via Paste Link
DDE Modes

3. Select the appropriate options.

4. When you are finished, select the OK button.

5. Minimize the AT&TBuzz window.

✏

PassageWay is now installed and configured. Refer to Chapters 3 through 7
for information on how to use the PassageWay applications.

NOTE:
If you set AT&TBuzz to run in Match to AT&TCallFile mode, you must run
AT&TCall, create a new AT&TCall file, and then associate your new AT&TCall
file with AT&TBuzz. Refer to Chapter 4 to run AT&TCall and create a new
AT&TCall file. Refer to Chapter 3 to associate a new AT&TCall file with
AT&TBuzz ("Changing the AT&TCall File Associated with AT&TBuzz").
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Using AT&TBuzz

Overview

This chapter provides the following information:

■     a description of AT&TBuzz

■     helpful hints describing how to use AT&TBuzz

■     the procedures for running AT&TBuzz

■     the tasks you will perform regularly while using AT&TBuzz

■     a description of all the AT&TBuzz menu options
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What Is AT&TBuzz?

AT&TBuzz is a software application that enables you to manage incoming calls
(answer, hold, or drop) and view Caller ID (when available) for each incoming
call appearing at your telephone.

✏ NOTE:
AT&TBuzz will only provide Caller ID for outside calls (when
passed from the telephone network) on PARTNER II Release 3.0
or 3.1 systems that have lines subscribed to Caller ID from your
local telephone company. In addition, these lines must be
plugged into a PARTNER 206EC or 400EC module on the
PARTNER system. AT&TBuzz does not support Caller ID for
internal (intercom) calls on any of the PARTNER systems.

Figure 3-1 shows the AT&TBuzz window running in No Matching mode.

Figure 3-1. Sample AT&TBuzz Window

3-2



Using AT&TBuzz

The AT&TBuzz window consists of the following components:

■    call record list box

■    menu bar

■    tool bar

Figure 3-2 shows the components of the AT&TBuzz window.

Figure 3-2. Components of the AT&TBuzz Window

The call record list box displays the call records for each incoming call
currently appearing at your telephone (that is, calls that are ringing, active, or
on hold). A call record consists of the following components:

■

■

Line label, which indicates the specific line button that the call is on.
You can customize these labels in AT&TConnect to identify each line
button on your telephone.

Call State, which indicates the status of the incoming call. Possible call
states are Ring, Active, or Hold.
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■

■

Caller ID (if available), which is the call origination information that may
be delivered with the incoming call. In addition, the following messages
may appear in this column:

— Inspecting

— Private

— Out of Area

— Not Available
If this column is blank, you may initiate an inspection of the Caller ID if
you have a Caller ID Inspect button programmed. To perform an
inspection, select the record in the list box and select the Inspect button
from the Tool bar. (Refer to "Using Caller ID information" for more
information regarding the messages that may appear in the Caller ID
column.

Call Label (if available), which is present if AT&TBuzz is operating in
Match to AT&TCall File mode or Export via Paste Link DDE mode.
Depending on the run mode, this field may contain information from an
AT&TCall file or another Windows application.

When an incoming call rings at your telephone, the call record for that call
appears on the first line of the call record list box and is highlighted (selected).
At this point, you can select the Answer button from the Tool bar to answer the
call. If other calls ring at your telephone while you are active on the first call,
AT&TBuzz displays the call records for each call in the order in which they
started ringing. The oldest call appears at the top of the call record list box,
and the newest call appears at the bottom. These call records will remain in
the call record list box as long as they are ringing, active, or held. As soon as
you hang upon a call, the record for that call is removed from the call record
list box.
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When you want to answer a call, hang up a call, or place a call on hold, you
must select the related call record in the call record list box (using the mouse
or the arrow keys on your keyboard) and then select the appropriate button
from the Tool bar. The Tool bar may contain either two or three buttons
(depending on the run mode in which AT&TBuzz is operating) and a count of
the number of currently active incoming calls. The meanings of these buttons
depend on the call state of the selected call record. Using these buttons, you
can answer a ringing or held call, hang up an active call, inspect for caller
information for a call, or show the associated AT&TCall card (if available).

You can set AT&TBuzz to run in one of the following three modes:

■

■

No Matching
When running in No Matching mode, AT&TBuzz displays the Line,
State, and Caller ID for each incoming call. In this mode, the AT&TBuzz
window does not display a Call Label for each call.

Match to AT&TCall File
The Match to AT&TCall File mode integrates AT&TBuzz with AT&TCall
In this mode, you associate an AT&TCall file with AT&TBuzz. When you
receive an incoming call, AT&TBuzz automatically searches the
telephone numbers on every card in the AT&TCall file. If the Caller ID
from the incoming call matches a telephone number in one of the cards
in the AT&TCall file, AT&TBuzz displays the primary and secondary sort
fields from the card as the Call Label for the call. For example, if the
primary sort field is Last Name, and the secondary sort field is First
Name in the associated AT&TCall file, AT&TBuzz displays the text from
the Last Name, First Name fields for the Call Label. If a match is found,
you can have AT&TCall display the associated card automatically from
AT&TBuzz. If a match is not found, you can create a new card for this
caller and add the new card to the card bank of the associated
AT&TCall file.
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When running in Match to AT&TCall File mode, AT&TBuzz enables you
to specify how and when the card associated with an incoming call
appears. You can select one of the following options for displaying the
associated card (via the Options item from the Setup menu):

—

—

—

On Button Selection
Sets AT&TBuzz to display the associated card when you select
the Show Card button in the Tool bar or the Show Card option
from the Controls menu. If you perform either action, the
associated card appears.

Automatically on Answer
Sets AT&TBuzz to display the associated card automatically after
you answer the call. As soon as you answer the call, the
associated card appears.

Automatically on Ringing
Sets AT&TBuzz to display the associated card automatically while
the incoming call rings at your telephone. The PARTNER system
receives the Caller ID from the local telephone network between
the first and second ring. AT&TBuzz then takes the Caller ID and
searches for a match in the associated AT&TCall file. The
associated card appears as soon as a match is found.

■ Export via Paste Link DDE
The Export via Paste Link DDE mode enables AT&TBuzz to export the
Caller ID and the line label to another Windows application that supports
Paste Link DDE. In turn, AT&TBuzz may receive a string from that other
Windows application and use that string as a Call Label. Export via
Paste Link DDE mode requires that you write a macro in the other
application. Refer to Appendix C for more information.

Regardless of the run mode you select, AT&TBuzz also enables you to specify
whether or not you want to log incoming calls in the calll log. This call log is the
same one used by AT&TCall. You can set AT&TBuzz to keep a record of
either all the incoming calls you receive, only those calls that you answer, or
not log any incoming calls. At any time, you can access the Log Viewer via
AT&TBuzz to view the call log.
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To help you handle your incoming calls more quickly and easily, AT&TBuzz
enables you to set the following options:

■

■

■

what should be done with the active call when you attempt to answer
another incoming call. You can manually select to place on hold or drop
the active call every time or you can set AT&TBuzz to either drop the
active call automatically or place the call on hold automatically.

whether AT&TBuzz automatically inspects every incoming call that rings
at your telephone (that is, try to get Caller ID). If you set AT&TBuzz to
automatically inspect every incoming call, you should always answer
calls directly from AT&TBuzz, instead of answering calls directly from
the telephone. This prevents you from interrupting an "inspection" in
progress and answering a call other than the one you are expecting to
answer.

whether the AT&TBuzz window appears when your phone rings.

Using Caller ID Information

As mentioned previously, PARTNER II Release 3.0 or later systems support
Caller ID. Caller ID is call origination information (that is, the telephone number
of the telephone line from which the call is made) that may be delivered with
an incoming call. Whether or not an incoming call has Caller ID depends on
the telephone network. Unfortunately, all parts of the public telephone network
do not yet support Caller ID. As a result you may not be able to take
advantage of this feature yet You may receive the following information in the
Caller ID field:

■

■

the telephone number of the phone from which the call was made.

the message "Out of Area," which indicates that there was no Caller ID
for the associated call. If you receive a call from someone who is calling
from an area where the telephone company does not support Caller ID
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■

■

■

or an area that does not pass Caller ID to your area, you will not
receive Caller ID for this call. Instead, you will receive the message "Out
of Area."

the message "Private," which indicates that there was no Caller ID for
the associated call. This message appears when you receive a call from
a telephone number that has instructed the telephone company to block
Caller ID. This is common for people who have unlisted telephone
numbers and do not want other people to find out their telephone
numbers via Caller ID.

the message "-Inspecting-," which indicates that the application is
inspecting the line for Caller ID. You should not answer any calls directly
from the telephone if a call is in this state.

the message "Not Available," which indicates that the Caller ID was
inspected successfully, and there is no Caller ID information associated
with this call. This message could be caused by any of the following
circumstances:

— The call was answered before the Caller ID was delivered (that
is, you answered the call before the second ring).

— An error occurred in the transmission of the Caller ID from the
telephone network.

— The line the call appeared on is not properly equipped for Caller
ID (that is, it is not in a PARTNER II Release 3.0 or later system
with a 206EC or 400EC module).

— This line is not subscribed for Caller ID).

— The call is an intercom call.

If this column is blank, you may initiate an inspection of the Caller ID if you
have a Caller ID Inspect button programmed. To inspect for Caller ID, select
the record in the list box and select the Inspect button from the Tool bar.
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If you are using AT&TBuzz in Match to AT&TCall File mode, it is important to
realize that the Caller ID you receive from a caller does not always match the
telephone number that you may dial for that person. For example, suppose
you have a friend whose company has a telephone system with more than one
outside line. You know that this, person’s phone number is 555-8888, and you
have this information in a card in the associated AT&TCall file. Since this
person’s company has more than one outside line, the Caller ID for calls
coming out of that company can be different from the number you would dial to
call that company. When this person calls you, the Caller ID you receive may
not match the number you dial to call this person. For example, this person
calls you, and the Caller ID is 555-8889 (even though the telephone number
you dial for this person is 555-8888). AT&TBuzz will search all of the dialable
fields in the AT&TCall file to find a match. Since the Caller ID for this call does
not match this person’s telephone number, AT&TCall will be unable to show
this person’s call label or card. In this example, you could help prevent this
situation from occurring by including this other Caller ID in one of the dialable
fields in this person’s card. This way, when this person calls you again,
AT&TCall will be able to find a match.

When running AT&TBuzz in Match to AT&TCall File mode, AT&TBuzz will
display "xxxx Matches" (where xxxx is the number of matches) in the Call
Label field if a dialable field in more than one card in your AT&TCall file
matches the Caller ID of the incoming call. In this case, if you select the Show
Card button, the Multiple Matches dialog box appears, displaying the text from
the primary and secondary sort fields of each card that matches the Caller ID.
You may then select and view one of these cards or create a new card. The
text from the primary and secondary sort fields for the card you selected
appears in the Call Label column of the AT&TBuzz window for the remainder
of this call.
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Running AT&TBuzz

In order to run AT&TBuzz, you must access Windows and open the program
group that contains the AT&T PassageWay applications. To run AT&TBuzz,
just double-click on the AT&TBuzz icon. The AT&TBuzz icon appears on the
bottom of your PC screen.

Helpful Hints

When using AT&TBuzz, keep in mind the following information:

■

■

■

■

If you have programmed a Caller ID Inspect button, do not answer calls
until the PARTNER system has completed inspecting them. If you pick
up the handset before the system finishes inspecting a call, you may not
be connected to the call you expect.

Answer all incoming calls via the AT&TBuzz window.

If you run AT&TBuzz in Match to AT&TCall File mode, you must update
your area code if it changes.

If you are using a standard telephone, you must select the call record of
the call you want to answer and select the Select button before picking
up the handset If you do not perform this procedure, you may not
answer the call you expect to answer.
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Tasks

This section provides the tasks that you will perform while using AT&TBuzz.

Accessing the Log Viewer

To access the Log Viewer from AT&TBuzz:

1. Select Accessories from the controls menu.

A submenu appears.

2. Select Call Log.

The Log Viewer window appears.

For information on Log Viewer tasks, refer to Chapter 6.

Answering a Call

To answer a call:

System Phone

1. Select the call record of the call you want to answer in the call record
list box.

The selected call record is highlighted.

2. Select the Answer button from the Tool bar.

Shortcut:
Double-click on call record of the call you want to answer.
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Standard Phone

✏ NOTE:
For standard phones, it is important for you to select the Select
button from the Tool bar when multiple calls are present at the
extension. This is the only way for you to make sure you will
answer the call that you want.

1. Select the call record of the call you want to answer in the call record
list box.

The selected call record is highlighted.

2. Select the Select button from the Tool bar.

A dialog box appears, instructing you to lift the handset.

3. Lift the handset of your phone.

Shortcut:

1. Double-click on call record of the call you want to answer.

2. Lift the handset of your phone.
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Changing the AT&TCall File Associated
with AT&TBuzz

You can change the AT&TCall file that is associated with AT&TBuzz while you
are running AT&TBuzz in Match to AT&TCall File mode.

✏ NOTE:
You can only change the AT&TCall file associated with
AT&TBuzz when no calls are appearing at the phone.

To change the file:

1. Select Run Mode. . . from the Setup menu.

The Run Mode dialog box appears.

2 . Click the mouse in the AT&TCall File box and enter the name of the file
that you want to associate with AT&TBuzz or use the Browse button to
display files.

3. When you are finished, select the OK button.

Creating a New Card in the Associated
AT&TCall File

When running in Match to AT&TCall File mode, AT&TBuzz enables you to add
a new card to the associated AT&TCall file. You can add a new card using
either the New Card button in the Tool bar or the New Card option in the
Controls menu. The New Card button is only available when the selected
incoming call does not already have an associated card in the AT&TCall file.
However, you can use the New Card option in the Controls menu to create a
new card at any time.
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To add a new card:

1.

2.

Select the call for which you want to create a new card in the
associated AT&TCall file.

The selected call record is highlighted.

Select the New Card button in the Tool bar or New Card from the
Control menu.

The AT&TCall New Card window appears. If there is Caller ID
information in the currently selected call record, that information appears
in the bottom telephone number field in the card.

Exiting AT&TBuzz

To exit AT&TBuzz, select Exit from the Setup menu.

Resetting the Size of the AT&TBuzz Window

As in other Windows applications, you can resize the AT&TBuzz window. For
example, if you want to view more than three call records (which is the default)
in the AT&TBuzz window, you can extend the size of the window vertically. If
some of the call labels exceed the call record list box and you want to view the
entire call label, you can extend the size of the AT&TBuzz window horizontally.
If you want the AT&TBuzz window to return to its default size, select Reset
Default Window from the Setup menu.

Selecting a Call Record

In order to handle a call (for example, answer, hang up, or place on hold), you
must select the related call record in the call record list box. You can select
any call record by performing one of the following procedures:

■     clicking on the call record in the call record list box

■     using the arrow keys on the keyboard of your PC
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Setting AT&TBuzz for Auto-Hold

You can set AT&TBuzz to automatically place on hold the current incoming call
and answer another incoming call when you select another call and then select
the Answer button. To set Auto-Hold:

1. Select Options. . . from the Setup menu.

The Options dialog box appears.

2. Select the Auto-Hold First Call in the Answering Second Call group.

3. Select the OK button.

✏ NOTE:
Auto-Hold only applies if you answer the call from the AT&TBuzz
window. If you answer the second call from the telephone, you
will drop the first call. Auto-Hold only applies if the first call is
incoming. if you place an outgoing call via AT&TCall and then
receive an incoming call, Auto-Hold will not apply.

lf you want to be prompted for Hold or Drop on each attempt select the
Choose to Hold or Drop option in the Answering Second Call group.

Setting AT&TBuzz for Auto-Drop

You can set AT&TBuzz to automatically drop the current incoming call and
answer another incoming call when you select another call and then select the
Answer button. To set Auto-Drop:

1 . Select Options. . . from the Setup menu.

The Options dialog box appears.

2 . Select the Auto-Drop First Call in the Answering Second Call group.
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3. Select the OK button.

If you want to be prompted for Hold or Drop on each attempt select the
Choose to Hold or Drop option in the Answering Second Call group.

Setting AT&TBuzz to Show the
Associated AT&TCall Card Automatically

When running in Match to AT&TCall File mode, AT&TBuzz enables you to
specify whether you want AT&TBuzz to display automatically the AT&TCall
card associated with the Caller ID of the incoming call. If you want AT&TBuzz
to display the card automatically, you must then specify whether you want the
card to appear when the call rings at your telephone or when you answer the
call. If you do not want AT&TBuzz to automatically display the card, set the On
Button Selection option in the Options dialog box. You can then show the card
manually using the Show Card button in the Tool bar or the Show Card option
in the Controls menu.

To set when the AT&TCall card is displayed:

1.

2.

3.
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Setting the AT&TBuzz Window to
Appear Automatically

You can set the AT&TBuzz window to be brought to the front or restored from
its icon automatically when a call rings. To set the AT&TBuzz window to
appear automatically when a call rings:

1. Select Options. . . from the Setup menu.

The Options dialog box appears.

2. Click on the Show AT&TBuzz on Ringing check box to enable or disable
the automatic appearance of the AT&TBuzz window when your
telephone rings. An "x" in the check box indicates that the AT&TBuzz
window will automatically appear when your telephone rings.

3. When you are finished, select the OK button.

Setting the Area Code

If you are running AT&TBuzz in Match to AT&TCall File mode, AT&TBuzz
requires the local area code. If your area code changes, you must update the
area code in AT&TBuzz. To change the area code:

1. Select Options. . . from the Setup menu.

The Options dialog box appears.

2. Enter your area code in the Local Area Code field.

3. Select the OK button.
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Setting the AT&TBuzz Window to Always
be on Top of Other Windows

AT&TBuzz enables you to specify that you want the AT&TBuzz window to be
located on top of all the other open windows, including the active window. To
specify that the AT&TBuzz window is always on top of other windows, select
Always on Top from the Setup menu. A check mark appears next to the
Always on Top option, indicating that the option is activated. The AT&TBuzz
window will now remain in front of all the other windows you open, even if it is
not the active window.

Setting Automatic Inspect Mode

AT&TBuzz enables you to specify whether you want to enable Automatic
Inspect Mode. If you enable Automatic Inspect Mode, AT&TBuzz automatically
inspects each call as soon as the call appears at the extension. When
Automatic Inspect Mode is disabled (which is the default), AT&TBuzz only
receives Caller ID for the first call that starts ringing at your telephone. If
another call rings at your telephone, you must select the call record for the call
and then select the Inspect button. If you enable Automatic Inspect Mode, you
should always answer calls from the application so that you do not interrupt the
inspect operation.

✏ NOTE:
Automatic Inspect Mode is disabled if you are using a PARTNER
system that does not support Caller ID or if you do not have a
Caller ID Inspect button programmed on your telephone.

To enable or disable Automatic Inspect Mode:

1. Select Options. . . from the Setup menu.

The Options dialog box appears.
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2. Click on the Automatic Inspect Mode check box to enable or disable
Automatic Inspect Mode. An "x" in the check box indicates that
Automatic Inspect Mode is enabled.

3. When you are finished, select the OK button.

Setting the Run Mode for AT&TBuzz

You can set AT&TBuzz to operate in one of the following three modes:

■

■

■

No Matching, where AT&TBuzz displays the Caller ID for each call (if
available), but does not display an associated Call Label.

Match to AT&TCall File, which enables you to associate AT&TBuzz with
an AT&TCall file.

Export via Paste Link DDE, which enables AT&TBuzz to export the
Caller ID and the line label to another Windows application that supports
Paste Link DDE. in this mode, AT&TBuzz may receive a string from the
other Windows application and use that string as a Call Label.

✏ NOTE:
You can change the run mode only when no calls are in the call
record list box.

To set the run mode:

1. Select Run Mode. . . from the Setup menu.

The Run Mode dialog box appears.

2. Select the appropriate Run Mode option.

If you select the Match to AT&TCall File option, you must enter the path
and filename of the AT&TCall file that you want to associate with
AT&TBuzz.
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3. Select the OK button.

When you select the Match to AT&TCall File option for the first time,
AT&TBuzz will prompt you to enter your area code.

When you select the Export via Paste Link DDE Mode option, you will
display two dialog boxes.

Setting AT&TBuzz to Log Incoming Calls

AT&TBuzz enables you to specify whether you want incoming calls logged in
the Call Log. However, incoming call logging is only done while AT&TBuzz is
running. If you want incoming calls logged, you must then specify which calls.
You may select one of the following choices:

■

■

■

All Incoming Calls
When this option is selected, every incoming call is logged in the call
log.

Answered Calls Only
When this option is selected, only the incoming calls that you answer at
your extension are logged in the call log.

No Incoming Calls
When this option is selected, none of the incoming calls are logged in
the call log.

To set which incoming calls are logged in the call log:

1. Select Options. . . from the Setup menu.

The Options dialog box appears.

2. Select the appropriate option in the Call Logging section of the dialog
box.

3. When you are finished, select the OK button.
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Showing the Card of an Incoming Call
on Demand

When running in Match to AT&TCall File mode, AT&TBuzz enables you to
view on demand the associated card of an incoming call. However, you can
only perform this procedure if the Caller ID for that call matches the contents of
a dialable number field of one or more cards in the associated AT&TCall file.
You can view the associated card using either the Show Card button in the
Tool bar of the AT&TBuzz window or the Show Card option from the Controls
menu. Both of these options are active if the Caller ID of the incoming call
matches one or more cards.

To view the card associated with an incoming call:

1. Select the call record whose card you want to view from the call record
list box.

The selected call record is highlighted.

2. Select the Show Card button from the Tool bar.

The associated card appears.

Using the Timer

AT&TBuzz provides a stopwatch that enables you to time anything that you
want. You can use the Timer to time the length of a call, but you need to
manually start and stop the Timer. The Timer is not tied to the call.

To use the Timer:

1. Select Accessories from the Controls menu.

A submenu appears.
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2. Select Timer.

The Timer window appears and immediately starts keeping time. The
Timer measures time in hours, minutes, and seconds. To reset the
Timer, select the Reset button. To stop the Timer, select the Stop
button. To restart the timer after it has been stopped, select the Start
button.

3. When you are finished using the Timer, select Close from the Control-
menu box of the Timer window.
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AT&TBuzz Menu Bar Options

AT&TBuzz provides the following options in the menu bar:

■    Setup

■     Controls

■     Help

This section describes the options contained in each AT&TBuzz menu.

Setup

The Setup menu contains the following options:

■

■

■

■

■

■

Run Mode...

Options...

Initialize Paste Link DDE (only available when AT&TBuzz is running in
Export via Paste Link DDE mode)

Reset Default Window

Always on Top

Exit

Run Mode. . .

Enables you to specify whether you want AT&TBuzz to display the Caller ID
for each incoming call, search an associated AT&TCall file for a match, or
export the Caller ID to another Windows application.
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Options...

Enables you to set the following options:

■

■

■

■

■

■

Show AT&TCall Card (if AT&TBuzz is operating in Match to AT&TCall
File mode)

Answering Second Call

Call Logging

Automatic Inspect Mode

Show AT&TBuzz on Ringing

Local Area Code (if AT&TBuzz is operating in Match to AT&TCall File
mode)

Initialize Paste Link DDE

Initializes AT&TBuzz for exporting via Paste Link DDE. This option overwrites
the contents of the clipboard and is only available when AT&TBuzz is
operating in Export via Paste Link DDE mode.

Reset Default Window

Restores the AT&TBuzz window to its default size.

Always on Top

Keeps the AT&TBuzz window on top of all other open windows, including the
active window. This prevents the AT&TBuzz window from being obscured by
other windows.

3-24



Using AT&TBuzz

Exit

Closes the AT&TBuzz application.

Controls

The Controls menu contains the following options:

■     Answer

■     Hang Up

■     Hold

■     Show Card

■     New Card

■     Accessories

Answer

Enables you to answer the selected call if it is ringing or on hold.

Hang up

Enables you to hang up the selected call if it is active.

Hold

Enables you to place the active call on hold.

Show Card

Enables you to view the associated AT&TCall card (if available) for the
selected call if a match exists in the associated AT&TCall file. This option is
only available when AT&TBuzz is operating in the Match to AT&TCall File
mode.
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New Card

Enables you to create a new card in the associated AT&TCall File. This option
is only available when AT&TBuzz is operating in the Match to AT&TCall File
mode.

Accessories

Enables you to access the Call Log and display the Timer.

Help

The Help menu contains the following options:

■

■

■

■

Contents

Search for Help on...

How to Use Help

About AT&TBuzz...

Contents

Enables you to access the online Help.

Search for Help on...

Opens the Search dialog box for online Help. You can look up Help
information by entering keywords in the dialog box.
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How to Use Help

Describes how to use online Help.

About AT&TBuzz...

Displays the Windows version number, the AT&TBuzz version number, the
mode in which you are operating Windows, the amount of memory (KB)
available on your system, and the size of the largest contiguous block of
memory (KB) available.
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Overview

AT&TCall is a card file application that enables you to maintain information
such as names, addresses, and telephone numbers. You specify the
information that you want to store. With AT&TCall, you can place calls directly
from your PC and keep a log of calls you make from the application.

This chapter provides the following information:

■     a description of AT&TCall

■      a tutorial describing how to use AT&TCall

■     helpful hints when using AT&TCall

■     the procedures for running AT&TCall

■     the tasks you will perform regularly while using AT&TCall

■     a description of all the AT&TCall menu options
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Before using AT&TCall, you should consult the following sections of this
chapter:

■

■

■

"What Is AT&TCall?," which describes AT&TCall and provides tasks that
you can perform with AT&TCall

"Getting Started," which is a tutorial that shows you how to use
AT&TCall

"Helpful Hints," which provides some "inside" tips and shortcuts that
maximize your time and effort when using AT&TCall

What Is AT&TCall?

As mentioned previously, AT&TCall is a card file application. To understand
how AT&TCall operates, it is helpful to recall how a card file works. A card file
is a unit that stores separate index cards, which are sorted according to
whatever method you want (usually alphabetical order) and contain specific
information you enter. When you obtain a new card file, it is usually empty.
You must then enter data on a card and add the card to the card file.
Eventually, the card file contains a "bank" of cards. If you want to modify a
card in the card file, you must find the card in the card file, remove it, make
your changes, and then place it back to its position in the bank. If you want to
remove a card, you must locate the card in the card file and remove it (usually,
you throw it away).

Each AT&TCall file can be thought of as being a separate card file unit. Each
AT&TCall file contains separate data entries, which are referred to as "cards."
The collection of these cards is referred to as a "bank." Each AT&TCall file can
contain a maximum of 2000 cards in its bank. These cards are sorted in
whatever manner you specify (via the sort option in the View menu) and
contain specific information that you enter. Figure 4-1 shows an untitled
AT&TCall window displaying a blank card. Figure 4-2 shows the components
of an AT&TCall window.
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Figure 4-1. Untitled AT&TCall Window
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Figure 4-2. Components of an AT&TCall Window
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When you create a new AT&TCall file, it does not contain any cards. The List
field, which lists the cards present in the file, is empty, and the screen displays
a blank card. As with a card file, you must then access a new, blank card (via
the New Card button), enter data on the blank card, and add the new card to
the bank of the AT&TCall file (via the Add Card button).

If you want to modify a card in the AT&TCall file, you must find the card that
you wish to modify, remove it from the card bank, make your changes to the
card (via the Edit Card button), and then place it back in the bank (via the
Return Card button). If you want to delete a card, you must locate the card in
the AT&TCall file and delete it (via the Delete Card option in the Edit menu)
from the bank of the AT&TCall file. If you make changes that you want to save,
you must save the entire card bank to a file (via the Save or Save As options
in the File menu).

Unlike a card file, AT&TCall enables you to perform the following tasks quickly
and easily:

■

■

■

■

■

■

place calls directly from a card

sort cards in a AT&TCall file any way you want

modify the card labels for all the cards in the AT&TCall file

keep track of all the calls you make

include notes for each card

implement passwords to prevent unauthorized use of your AT&TCall
files

Each AT&TCall file also provides a "desktop" with Quick Dials, which are
similar to autodial buttons on your telephone. AT&TCall provides a maximum
of 50 Quick Dials (two sets of 25) per file. However, if you need no more than
20 Quick Dials, you can set AT&TCall to display a maximum of 20 Quick Dials
(two sets of 10). AT&TCall also enables you to hide all of the cards in your
AT&TCall file. In this situation, only the Quick Dials, Hang Up button, Dialpad
button, Timer button, and Quick Shift button (if 50 Quick Dials are used) are
displayed.
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Depending on the number of Quick Dials you specified and whether the card is
hidden, your AT&TCall file desktop can have four different "looks." Figures 4-3,
4-4, 4-5, and 4-6 show these different desktop looks.

Figure 4-3. Desktop with 10/20 Quick Dials and Card
Shown
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Figure 4-4. Desktop with 10/20 Quick Dials and Card Hidden
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Figure 4-5. Desktop with 25/50 Quick Dials and Card Displayed
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Figure 4-6. Desktop with 25/50 Quick Dials and Card Hidden
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Getting Started

If you are using AT&TCall for the first time, it is a good idea for you to perform
the tutorial, which provides the basic procedures for using AT&TCall. This
tutorial takes approximately 15 minutes to complete and shows you how to
perform the following tasks:

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

Run AT&TCall.

Open an existing AT&TCall file.

Modify an existing card.

Create a new card.

Enter notes for a card.

Make a telephone call from AT&TCall.

Save an existing file.

Create a new file.

Customize the labels in a file.

Assign a telephone number to a Quick Dial.

Save a new file.

Exit AT&TCall.

After completing this tutorial, you will have performed most of the basic
procedures necessary to use AT&TCall.
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Step 1: Running AT&TCall

Before you can perform any AT&TCall tasks, you must run AT&TCall. In order
to run AT&TCall, you must first access Windows and open the program group
that contains the PassageWay applications. To run AT&TCall, just double-click
on the AT&TCall icon. An untitled AT&TCall window appears, displaying a
blank card (Figure 4-7). Figure 4-8 shows the components of an AT&TCall
window.

Figure 4-7. Untitled AT&TCall Window
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Figure 4-8. Components of an AT&TCall Window

At this point you can either enter information into this new file (by adding new
cards) or open an existing file. For this tutorial, you will open an existing file.
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Step 2: Opening an Existing AT&TCall File

In this step, you will learn how to open an existing file by opening the file
"sample.dex." This file was copied to your PC when you installed the
PassageWay applications.

To open an existing AT&TCall file, perform the following steps:

1. Select Open. . . from the File menu.

The Open dialog box appears.

2. Select sample.dex from the File Name box and select the OK button.

The AT&TCall file titled "SAMPLE.DEX" appears. This file was copied to
your hard disk during the installation procedure. AT&TCall displays the
last state of the card bank. Whenever you open an existing AT&TCall
file, the system displays the last card that was displayed before you
saved and exited that file.

4-13



Using AT&TCall

Step 3: Editing an Existing Card

In this step, you will learn how to modify the information that is present in an
existing card (that is, a card that was already created and added to the card
bank).

The displayed card information cannot be modified directly. To make any
changes to this information, you must "edit" the card. However, before you can
edit an existing card, you must first locate the card in the bank. AT&TCall
provides several methods for selecting a card:

■ clicking on the card in the List field

■ clicking on the Next and Previous arrow buttons located on each side of
the Show Notes button

■ clicking on the appropriate letter in the Slider, located at the bottom of
the AT&TCall window. For example, if the name you wanted started with
the letter "w," you could click on the "w" on the Slider. The first card that
began with the letter "w" would be selected and displayed.

To edit a card, perform the following steps:

1. Select the card "Kemp,Dave" from the card bank using one of the
methods described above.

The card for Dave Kemp appears.
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Figure 4-9. Card Display

2. Select the Edit Card button, which is located beneath the List field.

The Edit Card window appears and displays all of the information for the
selected card. The cursor is located in the top label field ("Last:"), and
the name "Kemp" is highlighted. The Edit Card button removes the card
from the card bank enabling you to modify the card.

✏ NOTE:
In the AT&TCall window, the Edit Card and New Card buttons are
"grayed" while you are editing or adding a card. Only one card
can be "out" of the card bank of an AT&TCall file at one time.
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Figure 4-10. Edit Card Window

You can move the cursor from field to field in the Edit Card window by
performing one of the following actions:

■

■

■

pressing [ TAB ➡❘ ] or [ ENTER ↵ ↵ ] to move the cursor to the next field

pressing [ SHIFT ]-[ TAB ➡❘ ] or [ SHIFT ]-[ ENTER ↵ ↵ ] to move the cursor to
the previous field

clicking the mouse on the field you want to select
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3.

4.

5.

6.

Using one of the methods described above, move the cursor to the
"Title:" field, and type Manager.

Using one of the methods described above, more the cursor to the
"Address:" field, delete 1010 Ocean Ave., and type 204 Main
Street.

Using one of the methods described above, mover the cursor to the
"City:" field, delete Sea Bright, and type Asbury Park.

Select the Return Card button.

The Edit Card window disappears, and the changes you made are
displayed. The modified card for Dave Kemp is returned to the bank.

Figure 4-11. Modified Card
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Step 4: Creating a New Card

In this step, you will learn how to create a new card, enter information into it,
and add the card to the bank.

To add a new card to the card bank, you must get a new, blank card, enter the
data in it, and then add the card to the bank. To add a new card to the card
bank, perform the following steps:

1 . Select the New Card button.

The New Card window appears, and the cursor is located in the "Last:"
field. The contents of this window is a new, blank card.
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Figure 4-12. New Card Window

2. Type Meyer.

3. Using one of the methods described previously, move the cursor to the
"First" field, and type Fred.

4. Select the Add Card button.

The New Card window disappears, the labels for the new card appear
in the List field, and information for the new card is displayed. The new
card is now part of the card bank.
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Figure 4-13. New Card

Now, create a new card for someone you know in your office. When entering
information in the new card, be sure to include that person’s phone number in
either the Office #, Home #, or Other # field. When entering telephone
numbers in a card, you must specify whether the number is an outside number
or an intercom (icom) number. The Office #, Home #, and Other # fields in
both the New Card window and the Edit Card window contain the lCOM/OUT
button, which toggles between outside and icom calls. If you click on this
button, the word "icom" appears. If you click on this button again, icom
disappears. When icom is displayed, AT&TCall expects you to enter an
intercom number. When icom is not displayed, AT&TCall expects you to enter
an outside phone number.
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If you want to enter an intercom number, click on the ICOM/OUT button to
display "icom," click the mouse in the field, and enter the intercom number. If
you want to enter an outside phone number, make sure the telephone number
field does not display "icom," click the mouse in the field, and enter the phone
number the same way as you would when you are dialing it from your
telephone.

When entering phone numbers in a card, you can also enter both numbers (for
example, 0-9) and alphabetic characters (for example, A-Z). For example,
suppose a restaurant has the phone number 555-RIBS (which is 555-7427).
Instead of typing all seven numbers in the phone number field for this card,
you can enter 555-RIBS.

You will use this new card in Step 6. After creating this card, select the card
"Meyer,Fred" from the card bank, and proceed to Step 5.

Step 5: Entering Notes for a Card

In this step, you will learn how to enter notes for the card that you created in
Step 4.

AT&TCall enables you to enter notes for each card in a card bank. The Notes
field can contain up to 32K. When a card contains notes, the Notes icon
appears to the left of the Show Notes button. To enter notes for a card,
perform the following steps:

1. Select the Show Notes button.

The card display is replaced by a blank "note pad."
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Figure 4-14. Note Pad

2. Select Insert Timestamp from the Edit menu.

The day, date, and time are inserted at the top of the note pad.

3. Type Must call tomorrow, and then select the Hide Notes button.

The card display replaces the notepad. The Notes icon appears to the
left of the Show Notes button, signifying that notes are present for this
card.
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Figure 4-15. Card with Notes Icon

Step 6: Making Calls

In this step, you will learn how to make a call from the card you created in
Step 4 for someone you know and also make a call from the Dialpad.

file:
 AT&TCall provides the following ways for you to make phone calls while in

■

■

■

the Dial buttons on each card

the Quick Dials in the AT&TCall window

the Dialpad
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From a Card

Making a phone call with a Dial button on a card consists of clicking on the
Dial button next to the phone number on the displayed card. To make a call
from a card, perform the following steps:

System Phone

1. Select the card you created in Step 4.

The card appears.

2 . Click on the Dial button next to that person’s phone number.

Your speakerphone activates, you hear dial tone, and AT&TCall dials
the phone number.

3 . Select the Hang Up button to disconnect the call.

Standard Phone

1. Select the card you created in Step 4.

The card appears.

2 . Click on the Dial button next to that person’s phone number.

AT&TCall prompts you to lift the handset of your telephone.

3 . Lift the handset of your phone.

AT&TCall dials the phone number.

4 . Hang up your handset to disconnect the call.
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From a Quick Dial

Making a phone call with a Quick Dial consists of clicking on the Dial button of
a Quick Dial that you have already programmed with a telephone number. This
procedure is described in Step 10.

From the Dialpad

Making a phone call using the Dialpad feature is similar to dialing a phone
number from your telephone. To make a call from the Dialpad, perform the
following steps:

System Phone

1 . Select the Dialpad button.

The Dialpad window appears.
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Figure 4-16. Dialpad Window

At this point, all of the buttons on the Dialpad are disabled except the

2.

3.

Dial Outside and Dial Intercom buttons. The Dialpad buttons become
enabled when you select either the Dial Outside button or the Dial
Intercom button.

Select the Dial Intercom button to make an intercom call.

The word "icom" appears in the display, your speakerphone activates,
and you hear intercom dial tone.

Using your PC keyboard or clicking on buttons in the Dialpad window,
enter an intercom number.

AT&TCall passes each digit of the intercom number to the PARTNER
system and places the call.
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4.

5.

6.

7.

8.

Press [ ALT ]-[ U ] on your keyboard or select the Hang Up button to
disconnect the call.

The intercom number you entered is automatically cleared from the
Dialpad display.

Select the Dial Outside button to make an outside call.

Your speakerphone activates, and you hear dial tone.

Using your PC keyboard or clicking on buttons in the Dialpad window,
enter an outside phone number.

AT&TCall passes each digit of the phone number to the PARTNER
system and places the call.

Press [ ALT ]-[ U ] on your keyboard or select the Hang Up button to
disconnect the call.

The outside phone number you entered is automatically cleared from
the Dialpad display.

Close the Dialpad window by selecting Close in the Control-menu box
of the Dialpad window.

Standard Phone

1. Select the Dialpad button.

The Dialpad window appears.
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Figure 4-17. DialPad Window

2. Select the Dial Intercom button to make an intercom call.

AT&TCall prompts you to lift the handset of your telephone.

3. Lift the handset of your phone.

You hear intercom dial tone.

4. Using your PC keyboard or clicking on buttons in the Dialpad window,
enter an intercom number.

AT&TCall passes each digit of the intercom number to the PARTNER
system and places the call.
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5. Hang up your handset to disconnect the call.

The intercom number you entered is automatically cleared from the
Dialpad display.

6. Select the Dial Outside button to make an outside call.

AT&TCall prompts you to lift the handset of your telephone.

7 . Lift the handset of your phone.

You hear outside dial tone.

8 . Using your PC keyboard or clicking on buttons in the Dialpad window,
enter a phone number.

When entering the telephone number, make sure you enter the number
the same way as you would when you are dialing it from your
telephone.

AT&TCall passes each digit of the telephone number to the PARTNER
system and places the call.

9 . Hang up your handset to disconnect the call.

The phone number you entered is automatically cleared from the
Dialpad display.

10. Close the Dialpad window by selecting Close in the Control-menu box
of the Dialpad window.
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Step 7: Saving an Existing File

In this step, you will learn how to save to the hard disk of your PC the changes
that you made to the existing file.

Now that you are done modifying the cards in the "sample.dex" file, you must
save your changes to disk. Select Save from the File menu. This procedure
saves the changes you made to "sample.dex" to the hard disk of your PC.

Step 8: Creating a New AT&TCall File

In this step, you will create a new AT&TCall file. New files are empty (that is,
they have no cards in the bank) and untitled. You will use this new file to learn
how to customize the labels of the card display in a file (Step 9).

To create a new AT&TCall file, select New from the File menu. An untitled,
empty AT&TCall file appears. This file is empty and displays a blank card.

Step 9: Customizing the Labels

In this step, you willl learn how to customize the labels of the card display of
the new file you created in Step 8.

When you initially access a new AT&TCall file, the system displays the default
labels for the cards (for example, "Last:," "First:," "Title:," and "Company:").
However, you can change these labels at anytime, enabling you to create
custom templates for the cards in your AT&TCall files. Whatever changes you
make to the labels apply only to the cards in the AT&TCall file in which you are
working. As a result you can have AT&TCall files with different labels on their
cards. However, all the cards in the file have the same labels.
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To customize the labels, perform the following steps:

1 . Select Edit Labels. . . from the Setup menu.

The Edit Labels dialog box appears.

Figure 4-18. Edit Labels Dialog Box

2. Using the methods described previously, move the cursor to Text Field
#7.

3. Delete State:, and enter Country:.
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4 . Select the OK button.

The Edit Labels dialog box disappears, and the new field label is
displayed on the card template.

Figure 4-19. Modified Card Labels

Step 10: Programming a Quick Dial

In this step, you will learn how to program a Quick Dial in the new AT&TCall
file that you created.

AT&TCall enables you to program Quick Dials for each AT&TCall file. Quick
Dials consist of two components: a Label button and a Dial button. The Label
button displays information you want to be displayed on the button (for
example, the person’s name). The Dial button dials the phone number you
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specified on the related card. AT&TCall Quick Dials act the same way as
autodial buttons on your telephone.

The card bank in this new AT&TCall window is empty. Since a Quick Dial dials
the phone number from a specified card, you must create a card before you
can program a Quick Dial.

To create a card, perform the following steps:

1. Select the New Card button.

The New Card window appears.

2. Fill out the card for someone you know. Make sure you enter a
telephone number for the person.

When entering the telephone number, specify whether the call is going
to be an outside call or an intercom call. Clicking on the button in the
phone number fields toggles between intercom and outside calls. Make
sure you enter the number the same way as you would when you are
dialing it from your telephone.

3. When finished, select the Add Card button.

The new card is displayed.

After creating a card, you can program the phone number for that card to a
Quick Dial. To program a Quick Dial, perform the following steps:

1. Press and hold down [ SHIFT ] and click on a Label button of a Quick Dial.

The Create Quick Dial dialog box appears, displaying the label that will
appear on the Quick Dial Label button and the telephone number that
the Quick Dial will dial. You may modify the label to make it more
descriptive to you and select the option button of the phone number that
you want this Quick Dial to dial (if more than one telephone number is
available).
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Figure 4-20. Create Quick Dial Dialog Box

When programming Quick Dials, you may want to modify the labels. For
example, suppose you want to program a Quick Dial for a friend’s office
telephone number, and also program a Quick Dial for that person’s
home telephone number. If you do not modify the Label buttons when
programming these Quick Dials, you will have two Quick Dials that have
the same labels, but dial different telephone numbers. By looking at the
Label buttons of these Quick Dials, you will be unable to determine
which Quick Dial dials the office telephone number, and which Quick
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Dial dials the home telephone number. In this case, it would make
sense to include terms such as "Home" or "Office" in the labels to
differentiate what each of the Quick Dials will dial.

2. When finished, select the OK button.

The Create Quick Dial dialog box closes, and the label appears on the
Label button of the Quick Dial.

To make a call from this Quick Dial, perform the following steps:

System Phone

1. Click on the Dial button of the Quick Dial that you just programmed.

Your telephone goes off hook, and AT&TCall places the call.

2. Select the Hang Up button to disconnect the call.

Standard Phone

1. Click on the Dial button of the Quick Dial that you just programmed.

AT&TCall prompts you to lift the handset of your telephone.

2. Lift the handset of your phone.

AT&TCall places the call.

3. Hang up your handset to disconnect the call.
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Step 11: Saving a New File

In this step, you will learn how to save the new file to the hard disk of your PC.

To save this new file to disk, perform the following steps:

1. Select Save As. . . from the File menu.

The Save As dialog box appears.
2. Enter trial in the File Name box.

✏ NOTE:
AT&TCall automatically adds the ".dex" suffix to the file name you
enter. If you prefer, you may enter another suffix. However, it is
recommended that you use the ".dex" default to make it easier to
identify and load AT&TCall files.

3. Select the OK button.

The Save As dialog box disappears, and "AT&TCall-TRIAL.DEX"
appears in the title bar of the AT&TCall window.

Step 12: Exiting AT&TCall

In this step, you will learn how to exit AT&TCall.

Now that you have completed the AT&TCall tutorial, exit AT&TCall. To exit
AT&TCall, select Exit from the File menu. The AT&TCall window closes.
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Helpful Hints

Once you have completed the tutorial, refer to the following hints:

■

■

■

Keep all AT&TCall files in the same directory.

By default AT&TCall saves and opens files from the directory in which
the PassageWay applications are installed. By keeping all the AT&TCall
files in the same directory, you can easily access your files.

Determine whether you need more than 20 Quick Dials.

AT&TCall enables you to program a maximum of 50 Quick Dials (two
sets of 25, which are accessed via either the Quick Shift button or the
Quick Shift option in the View menu). However, if you need no more
than 20 Quick Dials, you can set AT&TCall to display a maximum of 20
Quick Dials (two sets of 10, which are accessed via the Quick Shift
option in the View menu). See "Changing the Number of Quick Dials
Displayed," described later in this chapter.

Administer a password for your AT&TCall files.

To prevent unauthorized individuals from accessing your files,
administer passwords for your AT&TCall files. See "Protecting an
AT&TCall File with a Password," described later in this chapter.
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Running AT&TCall

In order to run AT&TCall, you must access Windows and open the program
group that contains the PassageWay applications. To run AT&TCall, just
double-click on the AT&TCall icon. Either an untitled AT&TCall file appears, or
an existing AT&TCall file is automatically loaded. (See "Specifying an
AT&TCall File to be Loaded Automatically," described later in this chapter, to
set AT&TCall to load a specific file automatically.) Refer to the following
section describing the tasks that you will perform regularly while using
AT&TCall.

Tasks

This section provides the tasks that you will perform while using AT&TCall.
These tasks are grouped into the following categories:

■     file tasks

■     card tasks

■     Quick Dial tasks

File Tasks

This section describes the tasks that you will perform when working in an
AT&TCall file.
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Accessing the Log Viewer

To access the Log Viewer from AT&TCall, select Call Log from the
Accessories menu. The Log Viewer window appears.

✏ NOTE:
For more information on Log Viewer tasks, refer to Chapter 6.

Changing How Cards are Sorted in an AT&TCall File

AT&TCall enables you to change the order in which cards are organized in the
card bank. To change how cards are sorted in your AT&TCall file:

1 . Select Sort. . . from the View menu.

The Sort dialog box appears.

Figure 4-21. Sort Dialog Box

2. Select the First box, and select the label of the field that you want
AT&TCall to sort by first.
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3. Select the Second box, and select the label of the field that you want
AT&TCall to sort by second.

4. Select the OK button.

The Sort dialog box disappears, and the cards are now sorted in the
card bank according to your specifications.

Creating a File Template

AT&TCall enables you to create a template for all new AT&TCall files that you
open. Once you create a template, all of your new AT&TCall files will have the
attributes (for example, specific labels or the number of Quick Dials that you
want displayed) that you specified in the template. For example, suppose you
want 25 Quick Dials, a card with your home phone number, and the first Quick
Dial programmed with your home phone number in every file that you create. If
you specify these attributes in your template, every new file that you create will
automatically have 25 Quick Dials, a card with your home phone number, and
the first Quick Dial programmed with your home phone number. At any time,
you can modify or delete this file.

To create a template:

1. Select New from the File menu.

A new, untitled AT&TCall window appears.

2. Customize the file to your specifications. For example, modify the labels,
add any cards that you want to appear in all of your new AT&TCall files,
and specify the number of Quick Dials you want in all of your new
AT&TCall files.

3. When you are finished, select Save As. . . from the file menu.

The Save As dialog box appears.
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4. Enter attcall.tpl in the Filename box and select the OK button.

The template is now saved. Every new file you open will now contain
the attributes that you specified in your template.

Creating a New AT&TCall File

To create a new AT&TCall file:

1.

2.

3.

4.

Select New from the File menu.

A new, empty AT&TCall file with the title "(UNTITLED. DEX)" appears.
When you save this file, the system will prompt you to name the file.

Enter your information in this file.

When you are finished working and want to save this file, select Save
As. . . from the File menu.

The system prompts you to name this file.

Enter the file name in the File Name box, and then select the OK
button.

The name of the file appears in the title bar of the window.

Dialing a Phone Number with the Dialpad

To dial a phone number with the Dialpad:

System Phone

1. Select the Dialpad button.

The Dialpad window appears.
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2.

3.

4.

5.

Perform one of the following steps:

■   To make an intercom call, select the Dial Intercom button.

Your speakerphone activates, and you hear intercom dial tone.

■   To make an outside call, select the Dial Outside button.

Your speakerphone activates, and you hear dial tone.

Using your PC keyboard or clicking on buttons in the Dialpad window,
enter the phone number.

When entering the telephone number, make sure you enter the number
the same way as you would when you are dialing it from your
telephone.

AT&TCall passes each digit of the telephone number to the PARTNER
system and places the call.

When the call is completed, press [ ALT ]-[ U ] on your keyboard or select
the Hang Up button to hang up.

The telephone number you entered is cleared from the Dialpad display.

Close the Dialpad window by selecting Close in the Control-menu box
of the Dialpad window.

Standard Phone

1. Select the Dialpad button.

The Dialpad window appears.
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2.

3.

4.

5.

6.

Perform one of the following steps:

■     To make an intercom call, select the Dial Intercom button.

■      To make an outside call, select the Dial Outside button.

Lift the handset of your phone.

You hear dial tone.

Using your PC keyboard or clicking on buttons in the Dialpad window,
enter the phone number.

When entering the telephone number, make sure you enter the number
the same way as you would when you are dialing it from your
telephone.

AT&TCall passes each digit of the telephone number to the PARTNER
system and places the call.

When the call is completed, hang up your handset

The telephone number you entered is automatically cleared from the
Dialpad display.

Close the Dialpad window by selecting Close in the Control-menu box
of the Dialpad window.

Exiting AT&TCall

To exit AT&TCall, select Exit from the File menu.
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Exporting AT&TCall Information

AT&TCall enables you to export a single card or an entire AT&TCall file to a
file in the comma separated values format (".csv"), which can be used in other
applications. During the export procedure, AT&TCall takes the 12 fields on a
card and the associated Notes field and writes them out in a horizontal line in
a ".csv" file. This line of information from a card is referred to as a "record." If
you export an AT&TCall file that has 20 cards, the ".csv" file will have 20
records.

✏

To export an AT&TCall file or card:

NOTE:
When the information in a file is exported, the word "icom" is
removed from intercom numbers in the telephone number fields.
Only the two-digit number remains. In addition, all alphabetic
characters that appear in the telephone number fields are
converted to digits.

1.

2 .

3.
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Open the file that has the information you want to export.

The AT&TCall window appears.

✏ NOTE:
If you only want to export one card, select that card in the bank.

Select Export from the File menu.

A submenu appears.

Select All Cards. . . if you want to export the entire AT&TCall file, or
select Current Card. . . if you want to export the currently displayed
card.

The Export dialog box appears.
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Figure 4-22. Export Dialog Box

4. Enter the name of the file to which you want to save this information
and select the OK button.

The Export dialog box closes, and the new file is created.

Importing Files into AT&TCall

AT&TCall enables you to import files that were created in other applications.
To be imported by AT&TCall, these files must be in the comma separated
values format (".csv"). A ".csv" file consists of "records," which are horizontal
fields of data. Each field of data is separated from the next field by a comma
(,). Fields containing commas and/or fields consisting of more than one line
must be surrounded by quotes (" "). Each record is one group of related data.
The end of each record is signified by a carriage return. A ".csv" file can have
numerous fields in a record. However, AT&TCall will only import 13 fields of
data from each record in a ".csv" file. Three records in a ".csv" file may look
like this:

Nolan, Pat, "ABC Travel, Inc."
Ricker, Lisa, "ABC Travel, Inc."
Vidil, Rich, "ABC Travel, Inc."
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AT&TCall imports 13 horizontal data fields from the ".csv" file, and then places
the information in the 13 vertical fields of a card in an AT&TCall file (that is, the
12 card fields and the Notes field). If there are more than 13 fields of data in a
record, AT&TCall ignores the remaining data in that record and proceeds to
the next record. If there are less than 13 fields of data in a record, AT&TCall
assumes that the remaining fields in the record are blank and proceeds to the
next record. For example, if each record only contained two fields of
information, AT&TCall would place the information in the first two fields in a
card (for example, the "Last" and "First" label fields) and make the remaining
fields in that card blank. It would then proceed to a new card and enter the
information for the next record.

During the import procedure, AT&TCall scans the file to be imported, verifying
that the file is valid (that is, it is in the correct format) and that only numeric
characters will reside in the telephone number fields (that is, the ninth, tenth,
and eleventh fields) in a card in an AT&TCalll file. The telephone number fields
in a card accept all numeric digits, *, #, (,), hyphens, spaces, commas, and
periods.

✏ NOTE:
Even though AT&TCall enables you to enter alphabetic
characters in the telephone number field of an AT&TCall card,
AT&TCall does not import alphabetic characters into the
telephone number fields. In addition, if the contents of a field
exceeds the number of characters that can be displayed in the
card, the contents of the field will be truncated.

To import a file:

1 . Open the AT&TCall file in which you want the imported data to reside.

The AT&TCall file window appears.
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✏ NOTE:
If you are importing data into an existing AT&TCall file, the new
data will be sorted automatically as it is imported. As a result, this
new information will be "mixed in" with your existing information.

2. Select Import. . . from the File menu.

The import dialog box appears.

Figure 4-23. Import Dialog Box

3. Select the file that you want to import and select the OK button.

AT&TCall scans the file and then imports the records from the file (if the
file is valid). A dialog box appears, stating the number of cards (that is,
records) that were imported from the ".csv" file.
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Figure 4-24 AT&TCall Dialog Box

4. Select the OK button.

The dialog box closes, and the new information is displayed in the
AT&TCall window.

Opening an Existing AT&TCall File

To open an existing AT&TCall file:

1.

2.
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Select Open. . . from the File menu.

The Open dialog box appears, showing a list of the available ".dex" files
in the current directory and disk drive.

Select the AT&TCall file you want from the File Name box, and select
the OK button. You may use the drive and directory controls to switch
drives and/or directories.

The file is loaded, and AT&TCall displays the last state of the card bank.
Whenever you open an existing AT&TCall file, AT&TCall displays the
last card that was displayed before you saved and exited that file.
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Printing a Card List

AT&TCall enables you to print a list of the cards in an AT&TCall file. You may
specify the labels of the information that you want printed for each card. For
example, if you want the list to contain the last name, first name, and office #
for each card in the file, you must specify these labels in the Print List dialog
box. In this example, one field would contain "Last:," one field would contain
"First:," one field would contain "Office #:," and the three remaining fields
would each contain "(None)." "(None)" signifies that no label was selected and
that no information will be printed in this field. You may select up to six labels
whose information you want printed.

To print a list of the cards in an AT&TCall file:

1. Select Print List. . . from the File menu.

The Print List dialog box appears.

Figure 4-25. Print List Dialog Box

2. In each field, select the label of the information that you want printed for
each card.

3. When finished, select the OK button.

Printing begins, and a dialog box is displayed, which enables you to
cancel printing.
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Printing an AT&TCall File or Card

AT&TCall enables you to print either all of the cards in an AT&TCall file or only
the card that is currently displayed. When printing a file or card, you may
specify whether you want the notes associated with the card(s) displayed. If
you specify that you want the notes displayed, the system will print out each
card and its notes on its own page. The top of each page will contain the label
for the card, and the bottom of each page will contain the date, page number,
and file name.

If you specify that you do not want the notes displayed, the system will print
out four cards on each page. The top of each page will contain the labels for
the first and last cards on the page. The bottom of the page will contain the
date, page number, and file name. Figure 4-26 shows how the cards look with
and without the notes printed.
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Figure 4-26. Printed Cards With and Without the Notes
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To print an AT&TCall file or card:

1. Select Print Cards. . . from the File menu.

The Print Cards dialog box appears.

Figure 4-27. Print Cards Dialog Box

2.

3.

4.

Perform one of the following steps:

— If you want to print the card that is displayed currently, select the
option button for Current Card.

— If you want to print all the cards in the file, select the option
button for All Cards.

Select the Print Notes box if you want to print the notes associated with
the card(s).

When finished, select the OK button.

Printing begins, and a dialog box is displayed, which enables you to
cancel printing.
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Protecting an AT&TCall File with a Password

AT&TCall enables you to administer a password for each file, preventing
unauthorized people from accessing the file. Passwords may consist of up to
eight printable characters (that is, letters, numbers, and punctuation marks)
and are case sensitive (that is, AT&TCall can differentiate between capital
letters and lowercase letters). After a password is administered for a file,
AT&TCall prompts you to enter a password every time you attempt to access
that file. You may administer passwords for as many AT&TCall files as you
like.

To administer a password for an AT&TCall file:

1. Select Save AS. . . from the File menu.

The Save As dialog box appears.

2. Select the Password button.

The Password Dialog box appears.

Figure 4-28. Password Dialog Box

3. Enter your password and select the OK button.

The Confirm Password dialog box appears.
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Figure 4-29. Confirm Password Dialog Box

4 . Re-enter your password and select the OK button.

5 . Select the OK button.

The next time you attempt to open this file, AT&TCall will prompt you for
the password.

Removing the Password from an AT&TCall File

To remove the password from an AT&TCall file:

1.

2.

3.

4.
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Open the AT&TCall file whose password you want to remove.

The file is loaded.

Select Save As. . . from the File menu.

The Save As dialog box appears.

Select the Password button.

The Password Dialog box appears.

Delete the password from the Enter Password field and select the OK
button.
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5. Select the OK button.

Saving an AT&TCall File

The next time you attempt to open this file, AT&TCall will not prompt
you for the password.

To save any changes to an existing AT&TCall file, select Save from the File
menu.  If the file is new, and has not been saved yet, select Save As. . . from
the File menu.

NOTE:✏
AT&TCall automatically adds the ".dex" suffix to the file name you enter. If you
prefer, you may enter another suffix. However, it is recommended that you use
the ".dex" default to make it easier to identify and load AT&TCall files.

Setting the Account Code Options

AT&TCall enables you to automate the process of account code entry if your
company uses account codes regularly, or if your telephone is administered for
Forced Account Code Entry (FACE). If you activate an account code option,
AT&TCall will use the contents of the last field (that is, the bottom field) of
each card as the default account code for calls made from that card. If no
account code is present, or the field contains information other than a valid
account code, AT&TCall will prompt you to provide one.

To set the Account Code options:

1. Select Account Code Options. . . from the Setup menu.

The Account Code Options dialog box appears.
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Figure 4-30. Account Code Options Dialog Box

2. Select the appropriate option button.

3. Select the OK button.

Setting the AT&TCall Window To Always Be on Top of Other
Windows

AT&TCall enables you to specify that you want the AT&TCall window to be
located on top (that is, in front) of all the other open windows, including the
active window. This option is especially useful when you are using AT&TCall in
the Card Hidden mode and want to keep a set of programmed Quick Dials
readily available.

To specify that the AT&TCall window is always on top of other windows, select
Always on Top from the Setup menu. A check mark appears next to the
Always on Top option, indicating that the option is activated. The AT&TCall
window will now remain in front of all the other windows you open, even if it is
not the active window.
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Setting the Dial Options

AT&TCall enables you to specify a prefix and/or suffix that the system will add
to all telephone numbers dialed via Dial buttons in the associated AT&TCall
file. For example, if you must enter a "9" before dialing a telephone number
outside of your PARTNER Communications System (that is, an outside call),
you can specify the prefix "9" in the Dial Option dialog box. However, if you
specify a Dial Option, the system will use that option for each and every
outside (non-icom) call you initiate from any Dial button in that AT&TCall file.
Therefore, if you use Dial Options, make sure all of the telephone numbers in
all of the cards in that AT&TCall file require the same Dial Option.

✏ NOTE:
Dial Options only apply to outside calls. Dial Options are not
applied to intercom calls.

To set Dial Options:

1. Select Dial Options. . . from the Setup menu.

The Dial Options dialog box appears.

Figure 4-31. Dial Options Dialog Box
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2.

3.

4.

Select Prefix and/or Suffix, depending on your requirements.

The box next to the option you selected is checked.

In the field next to the option you selected, type the prefix or suffix.

Select the OK button.

The Dial Options dialog box disappears.

Specifying an AT&TCall File To Be Loaded Automatically

AT&TCall enables you to specify a file that will be loaded automatically every
time you access AT&TCall. To specify a file to be loaded automatically:

1.

2.

3.

4.

5.

6.

7.

Exit AT&TCall.

Locate the AT&T PassageWay group window in Program Manager.

Select the AT&TCall icon with a single click.

The AT&TCall icon is highlighted.

Select Properties. . . from the File menu of Program Manager.

The Program item Properties dialog box appears:

Place the cursor in the Command Line box.

Move the cursor to the end of the Command Line box after
attcall.exe.

Press the spacebar on your keyboard, and then enter the name and
extension of the AT&TCall file that you want to be loaded automatically.
If the file does not reside in the same directory as AT&TCall, you must
specify the path in front of the file name.
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NOTE:✏
You must include .dex at the end of the file name. Otherwise,
the system will be unable to load this file automatically.

Figure 4-32 shows how the Program Item Properties dialog box would
look if you set the "sample.dex" file to be loaded automatically.

Figure 4-32. Sample File to be Loaded Automatically

8 . Select the OK button.

The Program Item Properties dialog box closes. The next time you
access AT&TCall, the file you specified will be automatically loaded.
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Card Tasks

This section describes the tasks that you will perform when working on cards
in an AT&TCall file.

Accessing the Notes Field

AT&TCall enables you to maintain notes for each card. The Notes icon
appears to the left of the Notes button when the card has information in the
Notes field. The Notes field can contain up to 32K. To access the Notes field
for a card:

1. Select the card of which you want to access the Notes field.

The selected card appears.

2 . Select the Show Notes button.

The Notes field appears.

3 . Enter information in the Notes field or modify the existing information (if
any) in the field.

4 . When you are finished, select the Hide Notes button.

The card is displayed.

Changing the Field Labels in the Cards

AT&TCall enables you to change the field labels for the cards in the bank. This
only applies to the bank you are in. To change the field labels:

1. Select Edit Labels. . . from the Setup menu.

The Edit Labels dialog box appears.

2 . Make your changes.
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3. When you are finished, select the OK button.

The Edit labels dialog box disappears, and your changes are displayed
on the card.

Creating a New Card

To create a new card:

1.

2.

3.

Select the New Card button.

field.
The New Card window appears, and the cursor is located in the first

Enter the appropriate information in each field that you use.

When you are finished entering information in this card, select the Add
Card button.

The New Card window doses, the labels for the new card appear in List
field, and the information for the new card is displayed.

Deleting a Card

To delete a card:

✏ NOTE:
When you delete an existing card, all Quick Dials associated with
that card are deleted.

1. Select the card you want to delete.

The selected card is displayed.
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2. Select Delete Card from the Edit menu.

The Delete Card dialog box appears.

Figure 4-33. Delete Card Dialog Box

3. Select the OK button.

The card is deleted from the bank, and the next card in the bank is
displayed.

Dialing a Phone Number from a Card

To dial a phone number from a card:

System Phone

1. Select the card that contains the phone number you want to dial.

The selected card is displayed.

2. Click on the Dial button located to the right of the phone number that
you want to dial.

Your speakerphone activates, you hear dial tone, and AT&TCall places
the call. After the call is completed, select the Hang Up button to place
your phone on-hook (that is, to hang up your phone).
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Standard Phone

1. Select the card that contains the phone number you want to dial.

The selected card is displayed.

2. Click on the Dial button located to the right of the phone number that
you want to dial.

AT&TCall prompts you to lift the handset of your telephone.

3. Lift the handset of your phone.

AT&TCall places the call. After the call is completed, hang up your
handset.

Editing an Existing Card

To edit an existing card:

1. Select the card you want to edit.

The card is displayed.

2 . Select the Edit Card button.

The Edit Card window appears containing the current information for the
card.

3. Make your changes to the card.

4. When you are finished, select the Return Card button.

The Edit Card window closes, and the updated card is displayed.
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Entering Telephone Numbers in a Card

When entering telephone numbers in an AT&TCall card, you must first specify
whether the telephone number is an intercom number. Every telephone
number field contains an ICOM/OUT button that toggles between intercom and
outside phone numbers.

You can enter both numbers (for example, 0-9) and alphabetic characters (for
example, A-Z) in the telephone number field of a card. For example, suppose
a restaurant has the phone number 555-RIBS (which is 555-7427). Instead of
typing all seven numbers in the phone number field for this card, you can enter
555-RIBS. When AT&TCall places a call to this phone number, it converts the
alphabetic characters to numbers.

To enter an intercom number:

1. In the Edit Card or New Card window, click on the ICOM/OUT button in
the telephone number field in which you are interested.

The word "icom" is displayed in the telephone number field.

2. Click the mouse in the field and enter the intercom number.

To enter an outside phone number:

1. In the Edit Card or New Card window, make sure that the word "icom" is
not displayed in the telephone number field in which you are interested.
If "icom" is present click on the ICOM/OUT button in the field.

2. Click the mouse in the field and enter the phone number.
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Hiding the Card Display

AT&TCall enables you to hide the card display and view only the Quick Dials,
the Hang Up button, the Dialpad button, the Timer button, and the Quick Shift
button (if the 25/50 Quick Dial Buttons option is selected). To hide the card
display, select Hide Card from the View menu.

Selecting a Card

You can select any card in the AT&TCall file by performing one of the following
steps:

■

■

■

■

clicking on the entry in the List field

clicking on the Next and Previous arrow buttons that are located on
each side of the Show Notes button

clicking on a letter on the Slider

using the Find and Find Next options from the Edit menu, and the
Next Card, Prev Card, Next Letter, and Prev Letter options
from the View menu

Showing the Card Display

To show the card display after hiding it via the Hide Card option in the View
menu, select Show Card from the View menu.

Using the Timer

AT&TCall provides a stopwatch that enables you to time anything that you
want. You can use the Timer to time the length of a call, but you need to
manually start and stop the Timer. The Timer is not tied to the call.
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To use the Timer:

1. When you want to start the timer, select the Timer button.

The Timer window appears and immediately starts keeping time. The
Timer measures time in hours, minutes, and seconds. To reset the
timer, select the Reset button. To stop the timer, select the Stop button.
To restart the timer after it has been stopped, select the Start button.

Figure 4-34. Timer
Window

2. When you are finished using the timer, select Close from the Control-
menu box of the Timer window.

Quick Dial Tasks

This section describes the tasks you will perform when using Quick Dials in an
AT&TCall file.

Accessing Information for a Quick Dial

To view the information for a Quick Dial:

1. Press and hold down [ SHIFT ] , and then click on the Dial button of the
Quick Dial in which you are interested.

The Quick Dial information dialog box appears. This dialog box presents
the label and phone number for this Quick Dial.
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Figure 4-35. Quick Dial Information Dialog
Box

2. When you are finished, select the OK button.

If you want to display the card associated with the Quick Dial, click on the
Label button of the Quick Dial in which you are interested. The associated card
is displayed.

Assigning a Phone Number to a Quick Dial

To assign a phone number to a Quick Dial:

1.

2.

Select the card that contains the telephone number that you want to
program to a Quick Dial.

The selected card is displayed.

Press and hold down [ SHIFT ] , and then click on the Label button of the
Quick Dial that you want to program.

The Create Quick Dial dialog box appears. The system provides a
default label.
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Figure 4-36. Create Quick Dial Dialog
B o x

3. Enter the label that you want to appear on the Label button of the Quick
Dial.

4 . Select the option button of the telephone number that you want this
Quick Dial to dial.

5. Select the OK button.

The label you entered appears on the Label button of the Quick Dial
you selected.
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Changing the Number of Quick Dials Displayed

AT&TCall allows you to program a maximum of 50 Quick Dials (two sets of 25,
which are accessed via either the Quick Shift button or the Quick Shift option
in the View menu). However, if you need no more than 20 Quick Dials, you
can set AT&TCall to display a maximum of 20 Quick Dials (two sets of 10,
which are accessed via the Quick Shift option in the View menu).

To specify the number of Quick Dials you want to access, select either
10/20 Quick Dial Buttons or 25/50 Quick Dial Buttons from the
Setup menu.

Changing the Setup of the Quick Dial Labels

AT&TCall enables you to display the information on the Label buttons of Quick
Dials as left-justified or centered. This setting applies to all AT&TCall files. To
change the setup of the information on the Label buttons of Quick Dials:

1 . Select Quick Dial Labels. . . from the Setup menu.

The Quick Dial label Setup dialog box appears.

4-69



Using AT&TCall

Figure 4-37. Quick Dial Label Setup Dialog
Box

2. Select the option button for the setup you want.

3. Select the OK button.

Dialing a Phone Number from a Quick Dial

To dial a phone number from a Quick Dial:

System Phone

Click on the Dial button of the Quick Dial in which you are interested. Your
speakerphone activates, you hear dial tone, and AT&TCall places the call.
After the call is completed, select the Hang Up button to place your phone on-
hook (that is, to hang up your phone).
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Standard Phone

1. Click on the Dial button of the Quick Dial in which you are interested.

AT&TCall prompts you to lift the handset of your telephone.

2. Lift the handset of your phone.

AT&TCall places the call. After the call is completed, hang up your
handset.

Erasing a Quick Dial

To erase the label and telephone number assigned to a Quick Dial:

1. Press and hold down [ SHIFT ], and then click on the Label button of the
Quick Dial that you want to erase.

The Change Quick Dial dialog box appears.

2. Select the Erase button.

The information for that Quick Dial is erased, and the Label button for
the Quick Dial is blank.

Re-Assigning an Existing Quick Dial

To assign a phone number to a Quick Dial that has been assigned previously:

1. Select the card that contains the telephone number that you want to
program to the Quick Dial.

The card is displayed.
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2. Press and hold down [ SHIFT ], and then click on the Label button of the
Quick Dial that you want to change.

The Change Quick Dial dialog box appears.

Figure 4-38. Change Quick Dial Dialog Box

3 .

4 .

5.

6 .

Select the Create New button.

The Create Quick Dial dialog box appears.

Enter the label that you want to appear on the Label button of the Quick
Dial.

Select the option button of the telephone number that you want this
Quick Dial to dial.

Select the OK button.

The label you entered appears on the label button of the Quick Dial
you selected.
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AT&TCall Menu Bar Options

AT&TCall provides the following options in the menu bar:

■     File

■     Edit

■     View

■     Setup

■     Accessories

■     Help

This section describes the options contained in each AT&TCall menu.

File

The File menu contains the following options:

■     New

■     Open...

■     Save

■     Save As...

■     Import...

■     Export

■     Print Setup...

■     Print Cards...

■     Print List..

■     Exit
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New

Creates a new, empty AT&TCall file. When selected, this option presents a
default screen with no entries. The window title displays "AT&TCall-
(UNTITLED.DEX)."

Open...

Enables you to open an existing AT&TCall file. When selected, this option lists
the existing AT&TCall files. You may scroll through the list and select a specific
f i le.

Save

Saves the changes made to the AT&TCall file on which you are working.

Save As...

Prompts you to name the file on which you are working. The default extension
for every AT&TCall filename is ".dex."

Import...

(.csv).

Export

Print Setup...

Enables you to import files that are in the comma separated values format

Enables you to export the current card or all cards in an AT&TCall file to a file
that is in the comma separated values format (.csv).

Displays the Windows printer setup window, allowing you to modify the printer
settings (for example, paper size and print orientation).
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Print Cards...

Enables you to print either all cards in an AT&TCall file or the card displayed
currently. When printing the card(s), you may specify whether you want the
notes associated with the card(s) printed also.

Print List...

Enables you to print specific label fields for each card in an entire AT&TCall
file. You may select a maximum of six labels.

Exit

Exits the AT&TCall application.

Edit

The Edit menu contains the following options:

■     Undo

■     Cut

■     Copy

■     Paste

■     Insert Timestamp

■     Clear Notes

■     Edit Card

■     New Card

■     Delete Card

■     Find...

■     Find Next
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You can use the Undo, Cut, Copy, and Paste options when you are performing
one of the following tasks:

■     editing an existing card

■     adding a new card

■     working in the Notes field of a card

Undo

"Undoes" the last editing action you performed in a field. For example, if you
change the information in a field and then select "Undo," the field displays its
previous information (that is, the information that was changed).

Cut

Deletes information selected from a field and places it in the Windows
Clipboard while you are editing a card.

Copy

Copies information selected from a field and places it in the Windows
Clipboard while you are editing a card.

Paste

Pastes information from the Windows Clipboard into the current field while you
are editing a card.

Insert Timestamp

Places the day, date, and time in the Notes field for the card displayed. This
information appears in front of the cursor and can be placed anywhere in the
Notes field.
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Clear Notes

Erases the contents of the Notes field for the card displayed.

Edit Card

Enables you to edit the card displayed on the screen.

New Card

Enables you to add a new card to the AT&TCall file.

Delete Card

Find...

Enables you to delete the card displayed on the screen.

Enables you to search for specific characters in each specified field or all fields
on each card in the AT&TCall file.

Find Next

Enables you to find the next card that matches the criteria you specified for the
Find option.
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V i e w

The View menu contains the following options:

■     Hide Card

■     Show Card

■     Hide Notes

■     Show Notes

■     Quick Shift

■     Next Card

■     Prev Card

■     Next Letter

■     Prev Letter

■     Sort...

Hide Card

Displays only the Quick Dials, the Hang Up button, the Dialpad button, the
Timer button, and the Quick Shift button (if the 25/50 Quick Dial Button option
is selected).

Show Card

Displays the entire card along with Quick Dials.
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Hide Notes

Closes the Notes field associated with the selected card.

Show Notes

Displays the Notes field associated with the selected card.

Quick Shift

Enables you to toggle between the first and second set of Quick Dials.

Next Card

Displays the next card in the AT&TCall file (as sorted).

Prev Card

Displays the previous card in the AT&TCall file (as sorted).

Next Letter

Enables you to "jump" to the next letter that contains a card in the AT&TCall
file.

Prev Letter

Enables you to "jump" to the previous letter that contains a card in the
AT&TCall file.

Sort...

Enables you to specify the primary and secondary labels by which the cards in
your AT&TCall file are sorted.
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Setup

The Setup menu contains the following options:

■

■

■

■

■

■

■

Edit Labels...

Dial Options...

Account Code Options...

Quick Dial Labels...

10/20 Quick Dial Buttons

25/50 Quick Dial Buttons

Always on Top

Edit Labels...

Enables you to modify any of the labels in the card template for your AT&TCall
file. When selected, this option displays a sample card with the current labels.
You may modify any of these labels.

Dial Options...

Enables you to enter a prefix and/or suffix that you want dialed with every
number. For example, if your telephone system requires that first you dial a "9"
before making a call using an outside line, you can specify "9" in the "Dial
Option..." prefix. By specifying your prefix, you do not need to include a "9" in
front of every phone number on every card.
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Account Code Options...

Enables you to administer one of the following account code options:

■

■

■

■

Ignore account codes, which ignores the account code.

Prompt for optional account codes before dialing, which prompts
you to enter an account code before dialing the number.

Prompt for optional account codes after dialing, which prompts you
to enter an account code after dialing.

Prompt for mandatory account codes before dialing (FACE), which
requires that you enter an account code before dialing. If the card does
not have an account code, the system prompts you to enter one.

Quick Dial Labels...

Enables you to display the Label button information for the Quick Dials as left-
justified or centered.

10/20 Quick Dial Buttons

Provides 20 Quick Dials for you to program and use. The system only displays
10 Quick Dials at a time. To access the second set of 10 Quick Dials, select
the Quick Shift option from the View menu.

25/50 Quick Dial Buttons

Provides 50 Quick Dials for you to program and use. When you select this
option, the system only displays 25 Quick Dials at a time. To access the
second set of 25 Quick Dials, either select the Quick Shift button in the lower-
right comer of the AT&TCall window or select the Quick Shift option from the
View menu.
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Always on Top

Keeps the AT&TCall window on top of all other open windows, including the
active window. This prevents the AT&TCall window from being obscured by
other windows.

Accessories

The Accessories menu contains the following options:

■     Call Log

■     Dialpad

■     Timer

Call Log

Enables you to access the Call Log, which contains information on all of the
calls you made from an AT&TCall file.

Dialpad

Enables you to access the Dialpad window. Using the Dialpad window, you
can place calls from the AT&TCall file.

Timer

Displays the Timer window, which contains a timer that immediately starts
running.
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The Help menu contains the following options:

■     Contents

■     Search for Help on...

■     How to Use Help

■     About AT&TCall..

Contents

Displays the topics in on-line Help.

Search for Help on...

Opens the Search dialog box for on-line Help. You can look up Help
information by entering keywords in the dialog box.

How to Use Help

Describes how to use on-line Help.

About AT&TCall...

Displays the AT&TCall version number, the Microsoft Windows version
number, the mode in which Windows is operating, the amount of free memory
(KB) available on your system, and the size of the largest contiguous block of
memory (KB) available.
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Using AT&TSet

Overview

This chapter provides the following information:

■

■

■

■

■

■

a description of AT&TSet

helpful hints describing how to use AT&TSet

the procedures for running AT&TSet

the tasks you will perform regularly while using AT&TSet

the tasks the System Manager will perform while using AT&TSet

a description of all the AT&TSet menu options

✏ NOTE:
AT&TSet supports the following PARTNER systems:

■     PARTNER II (all releases)

■     PARTNER PLUS (all releases)

■     PARTNER Release 3
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What Is AT&TSet?

AT&TSet is an application that enables you to perform Extension Programming
for your MLS-34D, MLS-18D, or MLS-12D telephone from your PC. Extension
Programming includes programming user features, Personal Speed Dial List,
and Extension Name (PARTNER PLUS Release 3.1 and PARTNER II Release
3.1 only). With AT&TSet, you can create and save multiple programming files
for your telephone. If you are a PARTNER System Manager, you can also
perform Centralized Telephone Programming for other extensions that have
any system or standard telephones. Centralized Telephone Programming
includes programming user features, Personal Speed Dial List, Automatic Line
Selection, and ringing options for line buttons. The System Manager can also
program the System Speed Dial List.

Each AT&TSet file consists of the programmable information for your
extension. Figure 5-1 shows the main screen of an AT&TSet file for an MLS-
18D telephone.
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Figure 5-1. AT&TSet File for an MLS-18D Telephone

When you run AT&TSet for the first time, the system "reads" the programming
from your telephone and displays an untitled file containing the current
programming for your telephone. When AT&TSet "reads" the programming
from your telephone, it identifies how each button or speed dial list entry on
your telephone is programmed, providing you with an accurate and up-to-date
status of the programming of your telephone. (If your PARTNER system
supports Extension Name, AT&TSet also reads this information from your
telephone.) The untitled file that AT&TSet displays after reading your telephone
is a "workspace" in which you may modify the programming of your telephone.
Every AT&TSet file can be thought of as a workspace. Figure 5-2 shows the
components of an AT&TSet window.
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Figure 5-2. Components of the AT&TSet Window
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Each AT&TSet file consists of the following items:

■     button programming

■     Personal Speed Dial List

■     Extension Name (if available)

■     System Speed Dial List (at a system administration extension)

■     Automatic Line Selection (at a system administration extension)

If you are the System Manager, you may perform Centralized Telephone
Programming on any extension (including your own). Files created at a system
administration extension also include the Automatic Line Selection list for the
extension being programmed. In addition, if you are the System Manager, your
AT&TSet file also includes the System Speed Dial List.

The main view of an AT&TSet file is the button programming. You must use
the menus to access the other options (for example, Personal Speed Dial List).
Each button in an AT&TSet file consists of a button label and a button position.
The button label shows the feature that is programmed to that button, and the
button position specifies the programming status of this button (use or skip).
Use and skip determine whether the feature that is programmed to this button
will be programmed on your telephone. To change the label or feature
programmed to a button, you must first select the button by clicking on the
particular button. When a button is selected, it becomes highlighted. At this
point, you can perform one of the following actions on the button:

■

■

■

■

change the feature that is programmed to the button (via the Change
Button Programming option in the Programming menu)

change the label of the button (via the Change Button Label option in
the Programming menu)

select the button to be programmed to your telephone (via the Use
Button When Programming option in the Programming menu)

retrieve full button programming information (via the Button Information
option in the Programming menu)
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Since AT&TSet files are workspaces, any changes you make to a file are not
immediately programmed to your telephone. To program these modifications to
your telephone, you must "write" the file to the telephone (via the Write to
Telephone option in the File menu). When you write a file to your telephone,
AT&TSet does not automatically program every button in the file to your
telephone. AT&TSet only programs buttons whose button positions display
"use." As a result, you can change how every button is programmed in an
AT&TSet file, but if you select "use" for only one button position, only that
button feature will be programmed to your telephone when you write the file to
your telephone. If you select "skip" for all of the button positions, none of the
button features in that file will be programmed to your telephone when you
write the file to your telephone.

With AT&TSet, you can create button programming files for any system
telephone. Regardless of the telephone model you have, you may create a file
for one of the other model types AT&TSet supports. For example, if you have
an MLS-34D telephone, you may create a file for an MLS-18D telephone.
AT&TSet also enables you to convert an existing AT&TSet file to a file for one
of the other model types.

NOTE:
You cannot directly write a file that was created for one type of telephone to
another type of telephone without first converting the file. For example, if you

✏

want to write a file for an MLS-34D telephone to an MLS-18D telephone, you
must convert the file to an MLS-18D file before writing the file to the MLS-18D
telephone.

With AT&TSet, you can program and print your speed dial lists. AT&TSet also
enables you to print labels for the button features programmed on your
telephone. You can print these labels on a perforated AT&T button label form.
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System Administration Capabilities

AT&TSet enables the PARTNER System Manager to perform the following
tasks:

■

■

Perform the following Centralized Telephone Programming tasks for any
user extension (system or standard telephone), including their own:

— perform all extension programming tasks (for example,
programming buttons and the Personal Speed Dial List)

— set the Automatic Line Selection order

— set the line ringing options for line buttons

Program and print the System Speed Dial List

Every PARTNER system allows you to perform system administration from
extension 10. However, you can perform system administration from
extensions 10 and 11 on PARTNER PLUS Release 3 or later and all releases
of PARTNER II.

✏ NOTE:
If both extension 10 and extension 11 are system administration
extensions, only one of these extensions may be used to perform
system administration at one time.

Refer to "Centralized Telephone Programming Tasks" for more information on
how to perform these tasks.
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Helpful Hints

When using AT&TSet keep in mind the following information:

■

■

■

Only program your telephone through AT&TSet. AT&TSet only keeps
track of programming you perform through this application. If you
program features via your telephone, you can cause AT&TSet to
become out of sync with your telephone.

Read the programming of your telephone at regular intervals to insure
that AT&TSet is in sync with the current programming of your telephone.
AT&TSet can become out of sync with the programming of your
telephone if either of the following actions occurs:

—

—

—

You program your telephone via your telephone, instead of using
AT&TSet.

The System Manager programs your telephone via Centralized
Telephone Programming or System Programming.

You add or move a Caller ID Inspect button via AT&TConnect
(PARTNER II Release 3.0 or later).

Do not save any files as "attset.img." AT&TSet uses this filename to
store the current programming of your telephone. Every time you modify
the programming of your telephone, AT&TSet updates this file. If you
save a file as "attset.img," you will cause AT&TSet to become out of
sync with your telephone.
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Running AT&TSet

In order to run AT&TSet, you must access Windows and open the program
group that contains the AT&T PassageWay applications. To run AT&TSet, just
double-click on the AT&TSet icon. An untitled AT&TSet file appears, displaying
the current programming of the buttons on your telephone.

The first time you run AT&TSet, the system presents the following dialog box:

Figure 5-3. AT&TSet Dialog Box

Select the OK button. AT&TSet starts reading the programming from your
telephone and displays a dialog box indicating the status.
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Figure 5-4. Reading Telephone Dialog Box

When AT&TSet finishes reading the programming from your telephone, an
untitled AT&TSet file appears, containing the current programming of your
telephone. Figure 5-5 shows a sample AT&TSet window.
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Figure 5-5. Sample AT&TSet Window

Refer to the following section describing the tasks that you will perform
regularly while using AT&TSet.
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Extension Programming Tasks

This section provides the extension prograrnming tasks that you will perform
while using AT&TSet. This applies to regular users and to System Managers
performing Centralized Telephone Programming.

Changing Button Labels

AT&TSet enables you to change the labels for programmed buttons. However,
changing the label for a button does not affect that button’s programming. To
change a button label:

1. Click on the button label that you want to change.

The button label you selected is highlighted.

2. Select Change Button Label . . . from the Programming menu.

The Change Button Label dialog box appears.

Figure 5-6. Sample Change Button Label
Dialog Box
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3. Modify the label.

4.  When you are finished, select the OK button.

The Change Button Label dialog box closes, your new button label
information is displayed, and the button position displays "use."

✏ NOTE:
Even if you only change the label of a button, you should write
this new file to the telephone. Otherwise, the new label will not be
saved in the "image file."

Shortcut

1. Double-click on the button label that you want to change.

The Button Information dialog box appears.

2. Select the Label button.

The Change Button Label dialog box appears.

Converting a File to a Different Button
Configuration

AT&TSet enables you to convert the button configuration in a file to one of the
other telephone configurations. AT&TSet supports all system telephones;
however, files for MLS-12, MLS-6, and MLC-6 telephones may be written to
the telephone only by the System Manager when performing Centralized
Telephone Programming.

To convert the button configuration:

1. Open the AT&TSet file that you want to convert.

2. Select Convert to from the File menu.
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A submenu appears displaying the telephone configurations supported.

3. Select the appropriate telephone configuration.

✏ NOTE:
If you made any changes to the current AT&TSet file, a dialog
box appears and prompts you to save your changes. Select the
Yes button if you want to save your changes.

A warning dialog box appears, prompting you to confirm that you want
to proceed.

✏ NOTE:
If you convert to a configuration with fewer buttons, you cannot
retrieve the button programming for the buttons that are deleted
during the conversion.

4. Select the Yes button.

AT&TSet displays a new file containing the converted information.

Creating a New File

You can create and save multiple AT&TSet files on your PC, enabling you to
customize your telephone as often and as much as you like. To create a new
fi le:

1. Select New from the File menu.

A submenu appears displaying the telephone configurations supported.

2. Select the appropriate telephone configuration.
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✏ NOTE:
If you made any changes to the current AT&TSet file, a dialog
box appears and prompts you to save your changes. Select the
Yes button if you want to save your changes.

AT&TSet displays a new file for the type of telephone you specified.
This file contains the information from the image file for this extension
(the state of the telephone programming from the last read or write).

Exiting AT&TSet

Using AT&TSet

To exit AT&TSet, select Exit from the File menu.

Identifying How a Button is Programmed

To determine how a button is programmed:

1. Click on the button label that interests you.

The button label you selected is highlighted.

2. Select Button Information. . . from the Programming menu.

The Button Information dialog box appears displaying the following
programming information:

—

—

—

feature assigned to the button

button label assigned to the button

information that may be associated with the button (for example,
extension, telephone number, or group number assigned to the
button)
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Figure 5-7. Button Information Dialog Box

At this point you may change the label or programming for this button.

If you are the System Manager, and you select a line button, the Line
Ringing options dialog box appears. If you are not the System Manager,
and you select a line button, you are unable to program it.

3. When you are finished, select the OK button.

Shortcut

Double-click on the button label that interests you. The Button Information
dialog box appears.
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Opening an Existing File

To open an existing file:

1. Select Open. . . from the File menu.

The Open dialog box appears.

2. Select the file you want to open.

The name of the file appears in the File Name list box.

3. Select the OK button.

The file you selected is displayed.

Printing Button Labels

Using AT&TSet

AT&TSet enables you to print the labels for buttons in an AT&TSet file. You
can print these labels on the perforated AT&T button label form.

✏ NOTE:
To print the button labels, you must use the PARTNER label
sheets. Other sheets will not line up properly. You can obtain the
appropriate PARTNER label sheets by placing an order with the
AT&T Customer Information Center (CIC). (See "Ordering
Information" in the front of this guide for the telephone number of
the AT&T CIC). Be sure to use the following ordering numbers:

■     MLS-6 - Order # 847-009-248

■     MLS-12/12D - Order # 847-009-255

■     MLS-18D) - Order # 847-086-964

■     MLS-34D - Order # 847-086-972
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To print labels:

1. Select Print Labels. . . from the File menu.

The Print Labels dialog box appears.

2. Select the checkbox of the location where you want the labels printed
on the button label form. If you have an MLS-34D, you can set AT&TSet
to print one or two sets of labels. If you have an MLS-18D, MLS-12D,
MLS-12, or MLS-6, you can set AT&TSet to print one to four sets of
labels.

3. Tape the sheet of labels to an 8.5 inch by 11.5 inch piece of paper, and
place this in your printer.

4 . Select the OK butlon.

The button labels are printed.

Printing the Personal Speed Dial List

AT&TSet enables you to print your Personal Speed Dial List. This print out
includes the following information for each speed dial code that is currently
programmed:

■     speed dial code number

■     number to be dialed

■     label

✏ NOTE:
Personal Speed Dial Lists are not available on PARTNER
Release 3.0.
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To print your Personal Speed Dial List:

1. Select Print Speed Dial List. . . from the File menu.

The Print Speed Dial List dialog box appears.

2. Select whether you want to sort the Personal Speed Dial List by label or
speed dial code.

If you sort the Personal Speed Dial List by code, AT&TSet will print
every speed dial code, including those that may not be programmed. If
you sort the Personal Speed Dial List by label, AT&TSet will print only
those speed dial codes that are programmed. AT&TSet will not print an
empty speed dial list

3. Select Personal Speed Dial.

4 . Select the OK button.

The Personal Speed Dial List is printed out in portrait mode, regardless
of how your printer is configured.

Printing the System Speed Dial List

AT&TSet enables the System Manager to print the System Speed Dial List.
This print out includes the following information for each speed dial code that
is currently programmed:

■     speed dial code number

■     number to be dialed

■     label

✏ NOTE:
This procedure can only be performed from a system
administration extension.
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To print the System Speed Dial List:

1. Select Print Speed Dial List. . . from the File menu.

The Print Speed Dial List dialog box appears.

Figure 5-8. Print Speed Dial List
Dialog Box

2.

3.

4.

Select whether you want to sort the System Speed Dial List by label or
speed dial code.

If you sort the System Speed Dial List by code, AT&TSet will print every
speed dial code, including those that may not be programmed. If you
sort the System Speed Dial List by label, AT&TSet will print only those
speed dial codes that are programmed. AT&TSet will not print an empty
speed dial list.

Select System Speed Dial.

Select the OK button.
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Programming a Button

AT&TSet enables you to program a new button or change the feature of a
button that has already been programmed in an AT&TSet file. Changing the
programming of a button in an AT&TSet file does not affect the current
programming of your telephone unless you select the button to be used (via
the Use Button When Programming option in the Programming menu), and
then write the button programming information in the file to your telephone (via
the Write to Telephone option in the File menu).

Unless you are the System Manager, you are unable to change the line ringing
options for line buttons. However, you can change the labels for the line
buttons.

✏ NOTE:
Extension 10 may have the following buttons programmed on the
telephone:

■     Night Service button

■     DXD button

■     ASA button

However, you cannot program these buttons using this
application since they are programmed through System
Programming. You can only change their labels.

To program a new button or change the feature of a button that has already
been programmed:

1. Click on the button label that you want to program.

The button label becomes highlighted.
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2.

3.

4.

5.
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Select Change Button Programming. . . from the programming
menu.

The Change Button Programming dialog box appears.

Select the option button of the feature that you want to program to this
telephone button in your AT&TSet file.

Select the OK button.

The Program Feature dialog box appears. This dialog box enables you
to use the default button label for this feature or customize the label.
Depending on the feature, this dialog box may prompt you to enter more
information for the feature (for example, an extension number). The
Help button provides an on-line help screen for the selected feature.

Perform one of the following steps:

—

—

If you want to use the default button label, select the OK button.

The Program Feature dialog box and Change Button
Programming dialog box disappear, and the default button label
appears on the button you selected. The button position for the
button you selected is highlighted and displays "use," signifying
that the programming for this button will be applied to your
telephone when you write the button programming for this file to
your telephone. The button label is gray.

If you want to change the default label, perform the following
steps:

a. Select the Label button.

The Change Button Label dialog box appears.
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b. Enter the label you want, and then select the OK button.

You return to the Program Feature dialog box, and the
new button label is displayed.

c. Select the OK button.

The Program Feature dialog box and Change Button
Programming dialog box disappear, and your custom
button label appears on the button you selected. The
button position for the button you selected is highlighted
and displays "use," signifying that the programming for this
button will be applied to your telephone when you write
this file to your telephone. The button label is gray.

Programming the Extension Name

If you have the PARTNER II Release 3.1 system or PARTNER PLUS Release
3.1 system, you can program the Extension Name associated with your
extension. When you make an intercom call to another extension from your
extension, your Extension Name appears on the telephone display of the
extension you are calling. If you have any other release of PARTNER, you can
assign an Extension Name. However, this name will only be printed on a label;
it will not be written to the system.

The Extension Name can be a maximum of 12 characters and may consist of
only the characters A through Z, 0 through 9, and blank spaces. AT&TSet
automatically converts all of the characters to upper case. The Extension
Name appears after the Name label in the AT&TSet window.

To program the Extension Name:

1 . Select Extension Name. . . from the Programming menu.

The Extension Name dialog box appears.
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Figure 5-9. Extension Name Dialog Box

2. Enter your Extension Name.

3. Select the OK button.

Programming the Personal Speed Dial List

AT&TSet enables you to program your Personal Speed Dial List, which can
contain a maximum of 20 telephone numbers. For each speed dial code in the
list, you may enter the number to be dialed and an associated label. Refer to
your PARTNER quick reference for more information regarding the Personal
Speed Dial Lists and the special dialing characters you may use.

When you write the Personal Speed Dial list to your telephone, only the
telephone numbers are written to the telephone. The associated labels are just
for your reference (that is, to help you easily identify the person or business
associated with the telephone number). The labels are printed when you print
your Personal Speed Dial List

✏ NOTE:
Personal Speed Dial Lists are not available on PARTNER
Release 3.0 or later.
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To program your Personal Speed Dial List

1 . Select Personal Speed Dial List . . . from the Programming
menu.

The Personal Speed Dial List dialog box appears.

Figure 5-10. Personal Speed Dial List Dialog Box

The Personal Speed Dial List consists of two pages, with each page
containing 10 speed dial codes.

3.

2. Enter the label and number to be dialed for the appropriate speed dial
code.

Select whether you want to apply the speed dial code and its associated
telephone number to your telephone when you write the Personal
Speed Dial List to your telephone. An "x" in the Use checkbox indicates
that the associated speed dial code will be applied to your telephone
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when you write the Personal Speed Dial List to your telephone. As soon
as you add or modify any of the information in the Personal Speed Dial
List, an "x" appears automatically in the Use checkbox.

4. When you are finished programming your Personal Speed Dial List,
select the OK button.

Programming the System Speed Dial List

AT&TSet enables the System Manager to program the System Speed Dial List.
For each speed dial code in the list, you may enter the number to be dialed
and an associated label. When you write the System Speed Dial List to your
telephone, only the telephone numbers are written to the telephone. The
associated labels are just for your reference (that is, to help you easily identify
the person or business associated with the telephone number). The labels are
printed when you print the System Speed Dial List. Refer to your PARTNER
quick reference for more information regarding the System Speed Dial List and
the special dialing characters you may use.

✏ NOTE
This procedure can be performed only from a system
administration extension. If there are two system administration
extensions, both extensions share the System Speed Dial List. If
one system administration extension edits this list and writes it to
the telephone, the other extension’s current list will be inaccurate.
You should read this information at your extension.

To program the System Speed Dial List:

1 . Select System Speed Dial List. . . from the programming menu.

The System Speed Dial List dialog box appears.
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Figure 5-11. System Speed Dial List Dialog Box

The System Speed Dial List consists of six pages, with each page
containing 10 speed dial codes.

2. Enter the label and number to be dialed for the appropriate speed dial
code.

3. Select whether you want to apply the speed dial code and its associated
telephone number to your telephone when you write the System Speed
Dial List to your telephone. An "x" in the Use checkbox indicates that
the associated speed dial code will be applied to your telephone when
you write the System Speed Dial List to your telephone. If you change
any of the information in the System Speed Dial list, an "x" appears
automatically in the Use checkbox.

4. When you are finished programming the System Speed Dial List, select
the OK button.
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Programming Your Telephone

The procedure to program your telephone enables you to write to your
telephone the button programming, Extension Name (PARTNER PLUS
Release 3.1 and PARTNER II Release 3.1 only), and Personal Speed Dial List
items that are selected as "use" in the currently displayed AT&TSet file. This
procedure changes the programming of your telephone.

✏ NOTE:
If you are the System Manager, you can also program the
System Speed Dial List and Automatic Line Selection.

To program your telephone

1. Open the file that has the feature(s) you want to program to your
telephone.

The selected file appears.

2. Select Write to Telephone. . . from the File menu.

The Write to Telephone dialog box is displayed.
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Figure 5-12. Write to Telephone
Dialog Box

3. Select the item(s) from this AT&TSet file that you want to write to the
telephone.

If you select Button Programming, all of the button features that display
"use" will be programmed to your telephone. If you have a PARTNER
PLUS Release 3.1 or PARTNER II Release 3.1 system, Extension
Name is also displayed in the Write to Telephone dialog box. If you
select Extension Name, the Extension Name information will be
programmed to your telephone. If you select Personal Speed Dial List,
all of the speed dial codes specified as "use" will be programmed to
your telephone.

4. Select the OK button.

AT&TSet starts writing your changes to the telephone and displays the
status.
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Figure 5-13. Sample Write to Telephone
Status Dialog Box

The selected items are programmed to your telephone.

Reading the Current Programming
from your Telephone

Every time you read the current programming from your telephone, AT&TSet
maintains a record of how the telephone is programmed. This information is
stored in the "image" file, which is named "attset.img." When you write new
features to your telephone, AT&TSet automatically updates this file, insuring
that it stays in sync with the programming of your telephone. However, it is
possible for AT&TSet to become out of sync with the programming of your
telephone. For example, you can cause AT&TSet to become out of sync with
the programming of your telephone by programming a feature directly from
your telephone. AT&TSet can only keep track of programming you perform
through this application and has no way of automatically knowing that you
programmed features directly from your telephone. An out-of-sync condition
can also occur if the System Manager changes the programming of your
telephone via Centralized Telephone Programming or System Programming.
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To help insure that AT&TSet is in sync with the programming of your
telephone, you should do the following:

■     only program your telephone via AT&TSet

■     read the programming of your telephone at regular intervals

To read the current programming from your telephone:

1. Select Read from Telephone. . . from the File menu.

✏ NOTE:
If you have made any changes to the AT&TSet file that is
currently displayed, the AT&TSet dialog box appears and prompts
you to save your changes. Select the Yes button if you want to
save your changes.

The Read from Telephone dialog box appears. This dialog box enables
you to select which item(s) you want to read from the telephone.

Figure 5-14. Read from Telephone
Dialog Box

If you have a PARTNER Release 3.1 or PARTNER II Release 3.1
system, Extension Name is also displayd in the Read from Telephone
dialog box. If you select Extension Name, the Extension Name
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information will be read from your telephone. If you select Personal
Speed Dial List, all of the speed dial codes will be read from your
telephone.

2. Select the item(s) that you want to read from the telephone and select
the OK button.

The Reading Telephone dialog box appears, informing you that the
system is reading the selected programming information from your
telephone.

Figure 5-15. Reading Telephone Status
Dialog Box

When the system is finished reading your telephone, the dialog box
disappears, and the programming information is displayed in a new,
untitled file. You can now modify and save this file.

5-32



Using AT&TSet

Saving a File

The procedures for saving a file depend on the following scenarios:

■ saving a new file (that is, one that has not been saved previously and
has the title AT&TSet for PARTNER-(UNTITLED.SET))

■ modifying an existing file and saving it under a new file name

■ saving changes to an existing file (that is, one that has been saved
previously and has a title)

Saving a New File

To save a new file (that is, a file that has the title AT&TSet for PARTNER-
(UNTITLED.SET)):

1.

2.

3.

Select Save AS. . . from the File menu.

The Save As dialog box appears.

Enter the name of the file.

The name of the file appears in the File Name list box.

✏ NOTE:
AT&TSet automatically adds the "set" suffix to the file name you
enter if you do not specify a suffix. If you prefer, you may enter
another suffix. However, it is recommended that you use the
".set" default to make it easier to identify and load AT&TSet files.

Select the OK button.

The Save As dialog box closes, and the new title appears at the top of
the window.
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Modifying an Existing File and Saving It as a Different File

Many times, you will create new files by modfying existing files. For example,
if you want to change one button in a file while maintaining that original file,
you can open that file, make your changes, and then save the modified file
under a new title. This way, you save time and effort and still have your
original file.

To save an existing file under a new title:

1. Select Save As. . . from the file menu.

The Save As dialog box appears.

2. Enter the name of the new file.

✏ NOTE:
AT&TSet automatically adds the ".set" suffix to the file name you
enter if you do not specify a suffix. If you prefer, you may enter
another suffix. However, it is recommended that you use the
".set" default to make it easier to identify and load AT&TSet files.

3. Select the OK button.

The Save As dialog box closes, and the new title appears at the top of
the window.
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Saving Changes to an Existing File

To save changes to an existing file, select Save from the File menu.

Selecting Buttons to be Programmed
to Your Telephone

Before you can program a button to your telephone, you must select the button
to be used. To select a button to be used when programming:

1. Click on the button label that you want to write to your telephone.

The button label is highlighted.

2. Select Use Button When Programming Phone from the
Programming menu.

The button position displays "use."

To select all of the buttons to be used when writing the file to your telephone,
select Use All Buttons from the Programming menu.

If you do not want a button to be used when programming, click on the label of
the button that you do not want to write to your telephone and select Skip
Button When Programming Phone from the Programming menu. The
button position displays "skip." If you do not want any of the buttons to be used
when writing the file to your telephone, select Skip All Buttons from the
Programming menu.
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Centralized Telephone Programming
Tasks

If you are the System Manager, AT&TSet enables you to also perform the
following Centralized Telephone Programming tasks for any user extension
(system or standard telephone) including your own:

■

■

■

perform Extension Programming (all tasks in the previous section except
tasks involving the System Speed Dial List)

set the Automatic Line selection order

set the line ringing options for line buttons

Every PARTNER system allows you to perform system administration from
extension 10. However, you can perform system administration from
extensions 10 and 11 on PARTNER PLUS Release 3 or later and all releases
of PARTNER II.

✏ NOTE:
If both extension 10 and extension 11 are system administration
extensions, only one of these extensions may be used to perform
system administration at one time.

Entering Centralized Telephone
Programming

AT&TSet enables you to perform Extension Programming for another
extension. While running AT&TSet from your extension, you can read and
program other extensions on the system, regardless of whether the extensions
have system phones or standard phones. When programming another
extension, you have the ability to "read" the current programming for that
extension and also "write" new features to that extension.
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Before allowing you to program (that is, write to) another extension, AT&TSet
prompts you specify the following information:

■     the extension that you want to program

■    whether you want to read the programming from the extension

■     the type of telephone at that extension

If you specify that you want to read the programming of the other extension,
AT&TSet then prompts you to specify which items you want to read from that
extension (for example, button programming). AT&TSet then reads the
programming from the extension that you want to program and displays the
current programming for that extension in the telephone configuration you
specify. For example, suppose you want to program extension 14, which is an
MLS-12 telephone. When prompted, you specify that you want AT&TSet to
read the button programming for extension 14 and display the information in
an MLS-12 file. AT&TSet then reads the programming for extension 14 and
displays the current programming in an MLS-12 file on your PC screen. In a
way, it is as if your PC is connected to the extension that you are
programming. When you make changes and write this file to the telephone,
these changes are written to the telephone of the extension you are
programming; these changes do not affect the telephone at your own
extension.

If you do not specify AT&TSet to read the programming from the other
extension, you will receive a new, blank file in the telephone configuration that
you specify. For example, if you specified that the extension had an MLS-12D,
AT&TSet displays an MLS-12D file with none of the buttons programmed.

NOTE:✏
When programming extensions that have standard telephones,
select the same telephone you have as the telephone type for the
extension. For standard telephones, you can program only the
Personal Speed Dial List (if supported by your PARTNER
system), Automatic Line selection, and line ringing options.
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When you read programming from your own extension or write programming to
your own extension, the "image" file for your extension is automatically saved
on your PC." However, when you read the programming of another extension
or write programming to another extension, the "image" file for that extension is
not automatically saved on your PC. If you want to save the information for
later use, you must save it to a file on your own PC.

To program another extension:

1 . Select Program Another Extension. . . from the programming
menu.

The Program Another Extension dialog box appears.

Figure 5-16. Program Another Extension
Dialog Box

2. Select the extension that you want to program.

3. Select the type of telephone at the extension that you want to program.
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4. Select whether you want to read the existing programming for the
extension that you want to program. An "x" in the Read Phone check
box indicates that AT&TSet will display the current programming for the
selected extension.

5. Select the OK button.

If you did not select the Read Phone check box, AT&TSet will display a
blank screen for the telephone type you selected (that is, there is no
programming information).

If you selected the Read Phone check box, the Read from Telephone
dialog box appears.

Figure 5-17. Read from Telephone
Dialog Box

Select the items that you want to read from the other extension and
select the OK button.

AT&TSet displays the current programming for the other extension.
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Figure 5-18. Sample AT&TSet File for Another Extension

Note that the Extension label notifies you which extension you are
currently programming. Whenever you are unsure which extension you
are programming, look at this label in the AT&TSet file.

At this point you may program this extension using the same
procedures described earlier in "Extension Programming Tasks" or
perform the following two tasks. When you want to exit Centralized
Telephone Programming, repeat steps 1 to 5, but select your own
extension in step 2.
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Setting the Automatic Line Selection

As System Manager, you can use AT&TSet to set the Automatic Line Selection
for each extension. Automatic Line Selection is the order in which the users
are connected to idle lines when they lift the telephone handset or press the
speaker button. The system always picks the first choice in the Automatic Line
Selection list that is inactive at the time. The Automatic Line Selection cannot
be read from the telephone. If the extension’s telephone programming is read,
the Automatic Line Selection indicated in AT&TSet may not accurately reflect
the telephone’s programming.

To set the Automatic Line selection:

1. Selected Automatic Line Selection. . . from the Programming
menu.

The Automatic Line Selection dialog box appears.
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Figure 5-19 Automatic Line Selection Dialog Box

2. Select the Start Again... button.

3. Select line and intercom buttons in the order in which you want the user
to access them.

4. When you are finished, select the OK button.

Setting the Line Ringing Options
for Line Buttons

AT&TSet enables you to set the ringing options for line buttons. To set the
ringing options for line buttons:

1. Select the line button that you want to modify.

The button becomes highlighted.
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2. Select Change Button Programming. . . from the Programming
menu.

The tine Ringing Options dialog box appears.

Figure 5-20. Line Ringing Options Dialog
Box

3. Select the type of line ringing.

4. Select the OK button.
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AT&TSet Menu Bar Options

AT&TSet provides the following options in the menu bar:

■     File

■     Programming

■     Help

This section describes the options contained in each AT&TSet menu.

File

The File menu contains the following options:

■    New

■    Open...

■    Save

■     Save As...

■     Convert to

■     Write to Telephone...

■    Read from Telephone...

■     Print setup...

■    Print Labels...

■     Print Speed Dial List..

■     Exit
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New

Enables you to create a new AT&TSet file for MLS-6, MLC-6, MLS-12, MLS-
12D, MLS-18D, MLS-34D, or standard telephones. When selected, this option
presents the current programming of your telephone. If you selected a
telephone type that has more buttons than your telephone, you will notice
additional blanks buttons in the new file. If you select a telephone type that has
fewer buttons than your telephone, you will notice that some buttons were
deleted. The window title displays "AT&TSet for PARTNER-[UNTITLED.SET]."

Open...

Enables you to open an existing AT&TSet file. When selected, this option lists
the existing AT&TSet files. You may scroll through the list and select a specific
file.

Save

Saves the changes made to the AT&TSet file on which you are working.

Save As...

Prompts you to name the file on which you are working. The default extension
for every AT&TSet filename is "set."

Convert to

Converts the currently displayed AT&TSet file to a system or standard
telephone AT&TSet file.

Write to Telephone...

Enables you to program the button features, Extension Name (if available),
and Personal Speed Dial List in your current file to your telephone. The
System Manager can also write Automatic Line Selection and the System
Speed Dial List. Only the selected items will be programmed to the telephone.
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Read from Telephone...

Accesses and displays the current programming of your telephone.

Print Setup...

Displays the Windows printer setup window, enabling you to modify the printer
settings (for example, printer type).

Print Labels...

Prints the features programmed on the buttons in a format that is consistent
with the set labels.

Print Speed Dial List...

Prints the number to be dialed and the associated label for each speed dial
code programmed.

Exit

Closes the AT&TSet application.
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Programming

The Programming menu contains the following options:

■

■

■

■

■

■

■

■

■

■

■

■

Button Information...

Change Button Programming...

Change Button Label...

Extension Name...

Personal Speed Dial List...

System Speed Dial List..

Automatic Line Selection...

Use Button When Programming Phone

Skip Button When Programming Phone

Use All Buttons

Skip All Buttons

Program Another Extension...

Button Information...

Displays the current programming of the selected button, and also enables you
to change the programming and label of the button.

Change Button Programming...

Enables you to program a new button or reprogram a currently programmed
button.
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Change Button Label...

Enables you to change the label for a button.

Extension Name...

Enables you to program the Extension Name for the extension. This option can
only be used on PARTNER II Release 3.1 and PARTNER PLUS Release 3.1
systems. However, you can have the Extension Name for the print out of
labels for other releases.

Personal Speed Dial List...

Enables you to program your Personal Speed Dial List. Personal Speed Dial
Lists are not available on PARTNER Release 3.0.

System Speed Dial List...

Enables you to program the System Speed Dial List. This option is only
available at system administration extensions while they are programming their
own telephones.

Automatic Line Selection...

Enables you to set the Automatic Line Selection for an extension. Automatic
Line Selection determines the order in which users will be connected to idle
lines when they lift the handset or press the speaker button of their phones.
This option is only available at system administration extensions.

Use Button When Programming Phone

Instructs the system to program the selected button in the file to the associated
button on the telephone when the Write to Telephone option is selected from
the File menu.
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Skip Button When Programming Phone

Instructs the system not to program the selected button in the file to the
associated button on the telephone when the Write to Telephone option is
selected from the File menu.

Use All Buttons

Instructs the system to program all of the buttons in the file to the associated
buttons on the telephone when the Write to Telephone option is selected from
the File menu.

Skip All Buttons

Instructs the system not to program any of the buttons in the file to the
associated buttons on the telephone when the Write to Telephone option is
selected from the File menu.

Program Another Extension...

Enables you to program another user's extension. This option is only available
at system administration extensions.
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Help

The Help menu contains the following options:

■     Contents

■    Search for Help on...

■     How to Use Help

■     Feature Browser

■     About AT&TSet...

Contents

Displays the topics in on-line Help.

Search for Help on...

Opens the Search dialog box for on-line Help. You can look up Help
information by entering keywords in the dialog box.

How to Use Help

Describes how to use on-line Help.

Feature Browser

Enables you to view information on any button feature.

About AT&TSet...

Displays the AT&TSet version number and the PARTNER version number.
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Overview

This chapter provides the following information:

■     a definition of Log Viewer

■     helpful hints when using Log Viewer

■     the procedures for running Log Viewer

■     the tasks you will perform regularly while using Log Viewer

■     a description of all the Log Viewer menu options
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What Is Log Viewer?

Log Viewer is an application that enables you to view entries that are stored in
the PassageWay call log. The call log stores a record entry of the following
calls:

■

■

Every call you make from the Dial buttons of a card or Quick Dials in an
AT&TCall file. The call log does not store entries of calls you make from
your telephone directly or from the Dialpad window in AT&TCall.

All incoming calls or only the incoming calls you answered (depending
on how you set the Call Logging option in the Options dialog box in
AT&TBuzz). The call log only stores entries of calls that arrive while
AT&TBuzz is running.

Figure 6-1 shows the Log Viewer window.
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Figure 6-1. Log Viewer Window

The call log can store a maximum of 8,000 entries. When this maximum is
reached, the oldest call entry (that is, entry 1) is overwritten by the newest
entry (that is, entry 8001 ). Each call log entry consists of the following
components:

■

■

■

the primary and secondary labels of the card associated with the call.
(For incoming calls, you only get this information if AT&TBuzz is running
in Match to AT&TCall File mode, and a match exists between the Caller
ID and an AT&TCall file card.)

the account code associated with the call

the telephone number associated with the call (that is, the dialed
number for outgoing calls and the Caller ID, if available, for incoming
calls).
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If there was no Caller ID for an incoming call, one of the following
messages may be displayed:

— "Not Available," which indicates that there was no Caller ID
associated with the call.

— "Not Inspected," which indicates that the call was never inspected
for Caller ID.

— "Out of Area," which indicates that there was no Caller ID
associated with the call. This message is delivered by the
telephone company.

— "Private," which indicates that there was no Caller ID for the
associated call. This message is delivered by the telephone
company.

Refer to "Using Caller ID Information" in Chapter 3 for more information
about Caller ID messages.

■

■

the type of call ("O" for outgoing calls, "l" for incoming calls that were
answered, and "U" for incoming calls that were not answered at this
extension)

the date and time the call started (that is, when the outgoing call was
dialed or the incoming call started ringing)

Log Viewer enables you to perform the following tasks with the entries in the
call log:

■    view selected entries

■    sort selected entries

■    delete entries

■    move entries from the log to a permanent archive file

■    print entries
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Using Log Viewer

When using Log Viewer, keep in mind the following information:

■

■

■

When the Log Viewer window is open, select the Refresh option from
the View menu to make sure you are viewing all of the entries you have
specified. If you make or receive a call while the Log Viewer window is
open, that entry will not be displayed in the Log Viewer. The Refresh
option insures that all relevant entries are displayed.

The call log stores a maximum of 8,000 calls. Entry 8001 overwrites the
oldest entry in the call log.

By default the system automatically adds deleted entries to the call log
archive file. The call log archive is an ASCII file in which each field of
data is separated by a tab. The archive file is called PWLOG.ARC and
is located in your Windows directory. This file can be viewed, edited, or
modified by any program that can access ASCII files. If you do not wish
to keep your call log entries permanently, turn off the "Add auto. deleted
entries to archive file" option from the Preferences option in the Setup
menu.

Running Log Viewer

To run Log Viewer, you must access Windows and open the program group
that contains the AT&T PassageWay applications. You can run Log Viewer by
itself, or access it from within the AT&TCall or AT&TBuzz applications. To run
Log Viewer by itself, double-click on the Log Viewer icon. The Log Viewer
window appears. Refer to the following section describing the tasks that you
will perform regularly while using Log Viewer.
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Tasks

This section describes the tasks that you will use with the Log Viewer.

Deleting Entries from the Call Log

To delete entries from the call log:

1. Select the entries that you want to delete from the Log Viewer window.
If you want to select all of the entries in the Log Viewer, select Select
All from the Edit menu.

The entries that you selected are highlighted.

2. Perform one the following steps:

— If you want to add these entries to the call log archive file, select
Moveto Archive from the Edit menu.

The PassageWay Log Viewer dialog box appears, displaying the
number of entries that will be deleted from the call log.

Figure 6-2. Sample PassageWay Log Viewer Dialog Box
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Select the OK button.

The entries are deleted from the log and added to the archive
file.

— If you do not want to add these entries to the call log archive file,
select Delete from the Edit menu.

The PassageWay Log Viewer dialog box appears, displaying the
number of entries that will be deleted from the call log.

Figure 6-3. Sample PassageWay Log Viewer Dialog Box

Select the OK button.

The entries are deleted from the log.
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Printing Log Entries

Log Viewer enables you to print the entries that are displayed in its window.

To print log entries:

1. Using the Filter/Sort Options option from the View menu, view the calls
that you want to print.

The specified calls are displayed in the Log Viewer window.

2. Select Print View from the File menu.

The entries displayed in the Log Viewer window are printed.

Setting the Log Viewer Preferences

You can set Log Viewer to perform the following procedures automatically:

■   delete entries after a specified number of days

■   add automatically deleted entries to the call log archive file

By default the call log archive keeps a copy of all entries that are
deleted automatically by the program (for example, exceeding the
maximum number of entries or deleting entries after a certain
number of days). These entries will not be added to the call log if
the "Add auto. deleted entries to archive file" option is turned off.

■   display a warning when a specified percentage of the call log is filled
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To set the preferences:

1. Select Preferences. . . from the Setup menu.

The Preferences dialog box appears.

Figure 6-4. Preferences Dialog Box

2. Select the preferences you want.

3. Select the OK button.
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Sorting Call Log Entries

Log Viewer enables you to specify the criteria for sorting call log entries and
the order in which these sorted entries are displayed. You can sort the
displayed entries according to the following criteria:

■   text label

■   telephone number

■   account number

■   date and time the telephone number was dialed

Sorted entries can be displayed in the order of oldest first or newest first.

To sort entries in the Log Viewer:

1. Select Filter/Sort Options. . . from the View menu.

The Filter/Sort Options dialog box appears.
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Figure 6-5. Filter/Sort Options Dialog Box

2. Select the option button of the Sort By option you want.

3. Select the option button of the Order option you want.

4. Select the OK button.

The Log Viewer displays the call log entries in the order in which you
requested. The top of the window displays the current sorting options.
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Specifying the Calls to be Displayed

Log Viewer enables you to specify which call log entries you want displayed in
the Log Viewer window. You can specify entries according to the following
criteria:

■     text label

■    telephone number

■    account number

■    date

■    call type

To specify the calls to be displayed:

1. Select Filter/Sort options. . . from the View menu.

The Filter/Sort Options dialog box appears.
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Figure 6-6. Filter/Sort Options Dialog Box

2. Select the filtering options you want.

3. Select the OK button.

Log Viewer displays the calls that you specified. The top of the window
displays the viewing selection.
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Log Viewer Menu Bar Options

Log Viewer provides the following options in the menu bar:

■    File

■    Edit

■    View

■     Setup

■    Help

This section describes the options contained in each Log Viewer menu.
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File

The File menu contains the following options:

■   Print View

■   Print Setup...

■   Exit

Print View

Prints the entries that meet the criteria you specified.

Print Setup...

Displays the Windows printer setup window, allowing you to modify the printer
settings (for example, paper size and orientation).

Exit

Exits the Log Viewer application.

6-15



Using Log Viewer

Edit

The Edit menu contains the following options:

■    Copy

■    Delete

■    Move to Archive

■    Select All

Copy

Copies the currently selected information from the Log Viewer window and
places it in the Windows Clipboard.

Delete

Deletes the currently selected information from the Log Viewer window. Once
deleted, this information is no longer present in the call log.

Move to Archive

Deletes the currently selected information from the Log Viewer window and
adds it to the call log archive file.

Select All

Selects all of the entries currently displayed in the Log Viewer window.
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View

The View menu contains the following options:

■    Filter/Sort Options...

■    Refresh

■    Hide Account Field

Filter/Sort Options...

Enables you to specify which calls you want displayed in the Log Viewer (that
is, filter), and the order in which you want the calls displayed (that is, sort).

Refresh

Updates the information displayed in the Log Viewer.

Hide Account Field

Enables you to either show or hide the account codes associated with the calls
displayed in the Log Viewer. A check next to this option indicates that the
account codes will not be displayed for each call.
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Setup

The Setup menu contains the Preferences option.

Preferences...

Enables you set Log Viewer to perform the following procedures automatically:

■    delete entries after a specified number of days

■    add automatically deleted entries to an archive file

■    display a warning when a specified percentage of the call log is filled

Help

The Help menu contains the following options:

■    Contents

■    Search for Help on...

■    How to Use Help

■    About PassageWay Log Viewer...

Contents

Enables you to access the on-line help for Log Viewer.

Search for Help on...

Enables you to access help information on a certain topic.
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How to Use Help

Describes how to use the on-line help for Log Viewer.

About PassageWay Log Viewer

Displays the Log Viewer version number, the number of entries currently in the
view (that is, the number of entries that meet the criteria you specified), the
capacity of the call log, and the number of entries in the call log.
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Using AT&TConnect

Overview

This chapter provides the following information:

■

■

■

■

a description of AT&TConnect

how to access AT&TConnect

tasks you may have to perform with AT&TConnect

a description of all the AT&TConnect menu options
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What Is AT&TConnect?

AT&TConnect is the manager for all the PassageWay applications. Even when
a user is not using a PassageWay application, but is using the adapter in
Autodial mode (or "Hayes" mode), the AT&TConnect software ensures correct
operation of the serial port.

Every time you invoke Windows, AT&TConnect is automatically loaded (unless
you removed the AT&TConnect icon from your StartUp group), and its icon
appears at the bottom of your screen. If you did not specify a valid COM port
when you installed the PassageWay software, the system will prompt you for a
COM port when you invoke AT&TConnect. After you specify the COM port,
AT&TConnect retains this information and does not prompt you for it again.

Once AT&TConnect has a valid COM port, the software attempts to
communicate with the adapter. If AT&TConnect is unable to communicate with
the adapter, the system displays a troubleshooting window. When
AT&TConnect successfully communicates with the adapter, the AT&TConnect
icon appears at the bottom of your screen.

Running AT&TConnect

If AT&TConnect is in your StartUp group, the AT&TConnect icon is displayed
automatically at the bottom of your screen when you access Windows. To run
AT&TConnect manually, you must first access Windows and open the program
group that contains the PassageWay applications. To access AT&TConnect,
double-click on the AT&TConnect icon at the bottom of your screen. The
AT&TConnect window appears.
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Figure 7-1. AT&TConnect Window
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Tasks

This section provides tasks that you may have to perform while using the
PassageWay applications.

Accessing the Events Log

If you are having problems with PassageWay and receive support from AT&T,
you may be asked to access the Events Log. The Events Log records certain
events for information purposes only and is used for diagnosing a problem.

To access the Events Log:

1. Select Events Log. .. from the Setup menu.

The Events Log dialog box appears.
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Figure 7-2. Events Log Dialog Box

2. When finished, select the OK button.
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Changing the COM Port

If for some reason you connect the PassageWay adapter to a different COM
port perform the following steps:

✏ NOTE:
You cannot select a new COM port for the PassageWay adapter
while PassageWay applications other than AT&TConnect are
running.

1. Select COM Port. . . from the Setup menu.

The COM Port Dialog Box appears.

Figure 7-3. Sample COM Port Dialog Box

2. Select the option button of the COM port to which you connected the
PassageWay adapter, and then select the OK button.
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Specifying the Version of Your PARTNER
System

If your PARTNER system is upgraded to a new version or release, you must
provide the updated information to AT&TConnect.

✏ NOTE:
You cannot change the PARTNER system information while
PassageWay applications other than AT&TConnect are running.

To update the PARTNER system information:

1 . Select Configure System. . . from the Setup menu.

The AT&TConnect Setup - System Configuration dialog box appears.

Figure 7-4. Sample AT&TConnect Setup - System Configuration Dialog Box
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2.

3.

4.

5.

Select the appropriate information, and then select the Continue button.

If you do not have a PARTNER II Release 3.0 or later system, the
AT&TConnect Setup - Line Labels dialog box appears. In this case,
proceed to step 4.

If you have a PARTNER II Release 3.0 or later system, the
AT&TConnect Setup - Caller ID Inspect Feature dialog box appears.

Select the Continue button.

The AT&TConnect Setup - Line Labels dialog box appears.

Select the Continue button.

The AT&TConnect Setup dialog box appears.

Select the OK button.

Changing the Labels of the Line Buttons

To change a line button label:

✏ NOTE:
You cannot change line button labels while PassageWay
applications other than AT&TConnect are running.

1. Select Configure System. . . from the Setup menu.

The AT&TConnect Setup - System Configuration dialog box appears.

7-8



Using AT&TConnect

2.

3.

Select the Continue button.

If you do not have a PARTNER II Release 3.0 or later system, the
AT&TConnect Setup - Line Labels dialog box appears (Figure 7-5). In
this case, proceed to step 4.

If you have a PARTNER II Release 3.0 or later system, the
AT&TConnect Setup - Caller ID Inspect Feature dialog box appears.

Select the Continue button.

The AT&TConnect Setup - Line Labels dialog box appears. The
highlighted buttons in this dialog box represent the line buttons on your
telephone.

Figure 7-5. Sample AT&TConnect Setup - Line Labels
Dialog Box
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4. Click on the button whose label you want to change.

The AT&TConnect Setup - Edit Line Label dialog box appears.

Figure 7-6. Sample AT&TConnect Setup -
Edit Line Label Dialog Box

5.

6.

7.
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Enter the new label (up to four characters) and select the OK button.

The AT&TConnect Setup - Edit Line Label dialog box closes, and the
new label is displayed.

When you are finished, select the Continue button.

The AT&TConnect Setup dialog box appears.

Select the OK button.
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Programming a Caller ID Inspect Button

To program a Caller ID Inspect button:

✏ NOTE:
You can program a Caller ID Inspect button only if you have a
PARTNER II Release 3.0 or later system. Also, you cannot
program a Caller ID Inspect button while PassageWay
applications other than AT&TConnect are running.

1. Select Configure System . . . from the Setup menu.

The AT&TConnect Setup - System Configuration dialog box appears.

2. Select the Continue button.

The AT&TConnect Setup - Caller ID inspect Feature dialog box
appears.
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Figure 7-7. Sample AT&TConnect Setup - Caller ID
Inspect Feature Dialog Box

3. Select the button that you want to program as an Caller ID Inspect
button.

The selected button displays "Inspect."

4. Select the Continue button.

The AT&TConnect Setup - Line Labels dialog box appears.
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5. Select the Continue button.

The AT&TConnect Setup dialog box appears.

6. Select the OK button.

Testing the PassageWay Adapter

If you are having problems with PassageWay Solution, perform the following
steps:

✏ NOTE:
You cannot test the PassageWay adapter while PassageWay
applications other than AT&TConnect are running.

1. Select Test Adapter from the Setup menu.

The AT&TConnect Adapter Test dialog box appears, and instructs you
to examine the LED located on the PassageWay adapter.

Figure 7-8. AT&TConnect Adapter Test
Dialog Box

2. Examine the LED on the PassageWay adapter, and then select the
appropriate button in the dialog box.
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3.

4.

Continue to respond to the AT&TConnect Adapter Test dialog boxes.

When the test is completed, the AT&TConnect Adapter Test message
box appears, displaying the results of the test.

✏ NOTE:
If the PassageWay Test fails, refer to Chapter 9.

Select the OK button.
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AT&TConnect Menu Bar Options

AT&TConnect provides the following options in the menu bar:

■   File

■   Setup

■   He lp

This section describes the options contained in the AT&TConnect menus.

File

The File menu contains the Exit option.

Exit

Exits the AT&TConnect software.

Setup

The Setup menu contains the following options:

■   COM Port...

■   Configure System...

■   Test Adapter

■   Events Log...
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COM Port...

Enables you to select the COM port for your PassageWay adapter.

Configure System..

Enables you to modify the system configuration information.

Test Adapter

Activates a self-test of the PassageWay adapter.

Events Log...

Records certain events for information purposes only and is used for
diagnosing a problem.

Help

The Help menu bar option contains the following options:

■    Contents

■    Search for Help on...

■    How to use Help

■    About AT&TConnect...

Contents

Enables you to access the on-line help for AT&TConnect.
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Search for Help on...

Enables you to access Help information on a certain topic.

How to use Help

Describes how to use the on-line help for AT&TConnect.

About AT&TConnect...

Displays the AT&TConnect version number, the PassageWay API DLL version
number, and the number of PassageWay applications (clients) that are
currently active.
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Using Autodialing Applications
with PassageWay Solution

Overview

This chapter provides information for using other Windows applications with
PassageWay Solution. Most applications that are designed to autodial (using
the Hayes' command set) can work with PassageWay Solution.

Using Autodialing Applications

Windows applications such as personal information managers (PIMs),
schedulers, and the Windows Cardfile dial phone numbers via modems using
the Hayes' command set. They do not use the modem to transfer data; rather,
they dial the phone number you select and expect you, the user, to pick up the
telephone to complete the call.

PassageWay Solution can decode the Hayes' commands necessary to dial a
telephone number. The application that performs the dialing will think there is
a modem connected to your PC, not PassageWay Solution. There are a few
parameters and guidelines that need to be followed to ensure that
PassageWay Solution will operate with your application.
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Modems communicate back to the PC, sending messages such as "OK" and
"Error." Most autodialing applications do not look for the modem to respond.
There are some autodialing application programs that rely on the modem
feedback. PassageWay Solution does not provide feedback, and the
applications that require it will not operate with PassageWay Solution.

Setting Up PassageWay Solution

To use PassageWay Solution with autodialing applications, the AT&TConnect
application must be running while the autodialing application is running.

✏ NOTE:
Other PassageWay applications (such as AT&TCall, AT&TSet,
and AT&TBuzz) cannot be running while PassageWay Solution is
being used by autodialing applications.

Also, when PassageWay applications are running, you cannot
use autodialing applications.
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Setting Up Your Application

Set the following parameters for your application:

■

■

■

■

■

Baud Rate

PassageWay requires that the application use 1200 baud.

COM Port

Make sure you select the same COM port that is connected to
PassageWay.

Data bits

The data bits (word length) should be set to 7 or 8.

Tone or Pulse dialing

Either setting will work with PassageWay Solution.

Prefix/Suffix

Whatever number you select for the application to use for a dialing
prefix and/or suffix will be used by PassageWay Solution.

✏ NOTE:
Stop bits and parity are not important to PassageWay Solution.
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Helpful Hints

Keep in mind the following information when using PassageWay Solution with
autodialing applications:

■ Make sure all phone numbers used are appropriate for your PARTNER
system.

■ Don't continue your application until the call is completely dialed. Many
applications have a dialog box with a message such as "Pick up Phone:
OK." This hangs up the modem. When using PassageWay Solution,
selecting the OK button will stop PassageWay Solution from dialing, but
will not hang up your telephone.
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Overview

This chapter provides information that can assist you in solving problems that
you might encounter with PassageWay Solution. This chapter is divided into
the following sections:

■   "Troubleshooting AT&TConnect"

■   "Troubleshooting AT&TCall"

■   "Troubleshooting AT&TSet"

■   "Troubleshooting AT&TBuzz"

Refer to the appropriate section to find the information required to solve your
particular problem. Also, you may want to refer back to the chapters discussing
the PassageWay applications to resolve problems that might arise due to
confusion about how a particular feature works. Keep in mind that AT&TCall,
AT&TSet, and AT&TBuzz depend on AT&TConnect in order to communicate
with your telephone. As a result, problems with AT&TCall, AT&TSet, or
AT&TBuzz may actually be caused by a problem with AT&TConnect.
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Troubleshooting AT&TConnect

This section presents some common problems that you might encounter while
using AT&TConnect. For each problem, a strategy is presented that you can
follow to isolate and solve your problem.

Problem 1: AT&TConnect will not run. It displays the message
This application requires a serial port and terminates.

This message indicates that AT&TConnect cannot find an available serial port
on your system. This message will most likely appear immediately after you
have completed the installation of the PassageWay software using the setup
program since this is the first time AT&TConnect tries to run.

If you do not have an available serial port (for example, if you have only one
serial port and this port is being used by your mouse), you will need to add an
additional serial port to your PC in order to use PassageWay Solution. Your
computer vendor can assist you in obtaining the necessary hardware to add
another serial port. See Appendix B for more information.

If you are certain that you have an available serial port (other than a port being
used by your mouse), the available port might be disabled, in which case
AT&TConnect will be unable to detect its presence. You can verify the number
of active serial ports in your system using the following procedure:

1. Exit Windows and return to DOS.

The DOS prompt appears.

2. Access the directory in which the PassageWay applications reside.
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3. Type comcheck and press [ ENTER ↵ ].

The status of each COM port in your PC is displayed. The following is a
sample of what you may see:

COMCheck V1.0 (c)1993 AT&T
Serial port detection program

Port
-----
COM1
COM2
COM3
COM4

Detected
----------
Yes
Yes
No
No

If this procedure reveals that your PC has no active COM ports or only COM1
is active (but is used by your mouse under Windows), you will need to either
purchase an additional COM port for your PC or consult your PC’s hardware
documentation to determine how to re-enable a COM port that might be
disabled. (Refer to Appendix B for information on COM ports.) Re-enabling a
COM port may require changing the placement of a jumper on your computer’s
system board or running your PC’s setup program.

9-3



Troubleshooting

Problem 2: AT&TConnect displays its Communications Error dialog box
within a few seconds after it is run

This message indicates that AT&TConnect cannot communicate properly with
your PassageWay adapter. This message can appear for one of the following
reasons:

■

■

■

■

Your PassageWay adapter is not connected properly to your PC serial
port and/or your telephone.

Your PassageWay adapter is not receiving power from the PARTNER
system.

AT&TConnect is administered to use a different serial port than the one
to which the PassageWay adapter is connected.

One or more cables and/or adapters is damaged or not compatible with
PassageWay Solution.
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AT&TConnect cannot communicate properly with
your PassageWay adapter.

Please follow the steps below, in order, to resolve the problem:

1.

2.

3.

4.

Verify that the adapter is present and properly connected to your
telephone and PC serial port.  If the adapter is not present, you
cannot use PassageWay to control your telephone, and you must
Press the "Quit" button below to exit this application.

Verify that the LED on the PassageWay adapter is illuminated.
If not, verify that the adapter is properly connected to the
jack on your telephone.

Verify that the proper communications port number [e.g., COM1,
COM2] is selected; you may review your current settings and
make changes by pressing the "Port" button below.

Press the "Test" button to initiate AT&TConnect's adapter
testing routing.  During the test, you may be prompted to
inspect the adapter LED you observed in step 2.

If all tests complete successfully, press the "Resume" button to
re-establish communications between AT&TConnect and the adapter.
If a test failed, note the error code and consult the user
documentation's "Troubleshooting" section for more information.

Figure 9-1. AT&TConnect - Communications Error Dialog Box
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You should follow the instructions provided on this dialog box to troubleshoot
the problem. These instructions ask you to verify the following items:

■ The PC-side and phone-side cabling associated with your PassageWay
adapter is properly connected.

Insure that the 7-foot phone cord is completely inserted into both the
jack marked "Line" of your telephone and the modular jack on the
PassageWay adapter. A proper connection is confirmed by a tactile
"click" as the cord is fully inserted.

Also insure that any RS-232 cables and adapters that you might be
using to connect the PassageWay adapter to your PC should NOT be
null modem cables (a special type of cable), and the total length of the
combined RS-232 cabling should not exceed about 40 feet (the length
should be as short as is convenient for your setup).

■ Insure your PassageWay adapter is receiving power from the PARTNER
system (as indicated by the illumination of the power LED).

If you have verified that the PassageWay adapter is properly connected
to your telephone, yet the power LED next to the modular jack on the
adapter is NOT illuminated, your telephone system wiring may not
support the remote powering of adjuncts. If this is the case, you should
consult your AT&T account representative or authorized dealer to obtain
the proper wall supply to power your PassageWay adapter or to correct
any wiring problems which may be the cause.

■ Your COM port administration for AT&TConnect corresponds to the
serial port to which the PassageWay adapter is connected.

Under Windows, AT&TConnect considers any active serial port that is
not being used by a serial mouse to be "available" for use with
PassageWay Solution. Consequently, AT&TConnect will allow you to
select a COM port that could be different from the one to which your
PassageWay adapter is attached. For example, if your PC contains an
internal fax/modem card, that fax/modem will be using one of your PC’s
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COM ports, and you could erroneously administer AT&TConnect to use
this same COM port. When selecting a serial port for AT&TConnect to
use, you should be careful that the COM port you select is not already
being used by another device in your PC.

■ AT&TConnect’s software-based adapter test passes.

To assist you in diagnosing problems, AT&TConnect contains a built-in
adapter test procedure. This test can be run directly from the
Communications Error dialog box by choosing the Test button.

If the test procedure concludes successfully, AT&TConnect is
communicating properly with your PassageWay adapter over the COM
port you selected, and you should select the Connect button on the
Communications Error dialog box to restore normal operation.

If, however, the test fails, an error number will be provided. Use the
following table to interpret the error numbers and to find suggestions for
how to resolve the particular error you encountered.
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Failure Code Meaning Things to Try

111 The PC and the Make sure you have
PassageWay selected the proper
adapter cannot COM port in
communicate over AT&TConnect.
your serial port.

Try replacing any
RS-232 cables or
adapters you are
using between your
PC’S COM port and
the PassageWay
adapter’s 25-pin
connector.

121 The PC and the Follow the
PassageWay instructions for
adapter cannot failure code 111.
communicate over
your serial port.

131, 132, 133, or The PC cannot Try replacing any
135 communicate RS-232 cables or

properly with your adapters you are
PassageWay using between your
adapter. PC’s COM port and

the PassageWay
adapter's 25-pin
connector.
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134 or 141 The PassageWay Try replacing the 7-
adapter cannot foot telephone
communicate cable between the
properly with your PassageWay
telephone. adapter and your

telephone.

200 and above A conflict or Try closing all
application error has Windows
occurred which applications except
prevented AT&TConnect and
AT&TConnect from Program Manager,
operating your PC then try the test
serial port. again.

You may need to
modify your
"autoexec.bat" and
"config.sys" files to
eliminate this
conflict.

Problem 3: AT&TConnect will not work on COM3 or COM4

By default many PCs are not configured to permit the simultaneous use of
three or more COM ports. Specifically, most PCs are configured such that
COM ports are grouped into pairs: COM1 is paired with COM3, and COM2 is
paired with COM4. By default such PCs permit only one COM port from each
pair to be operating at the same time (for example, COM1 with COM2). COM
ports within the same pair will usually conflict with one another and are not
supported (that is, COM1 with COM3, or COM2 with COM4).
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If you cannot get AT&TConnect to work properly on COM3, check if another
device is using COM1 at the same time. Similarly, if you cannot get
AT&TConnect to work on COM4, determine if another device is using COM2 at
the same time. If so, you may need to make some changes to your PC
configuration to support using PassageWay on COM3 or COM4. Refer to
Appendix B for more information. If you need additional assistance in setting
up devices on COM3 or COM4, consult your PC hardware vendor.

Problem 4: AT&TConnect occasionally displays its initialization window
while one or more PassageWay applications are running

AT&TConnect displays its initialization window whenever it establishes (or re-
establishes) communication with the PassageWay adapter. Generally, this
window is only displayed once, at the time when a single PassageWay
application is first executed. However, if a communications problem occurs at
any time, AT&TConnect attempts to clear the problem by reinitializing the
adapter, which causes the initialization window to reappear temporarily. If this
occurs while a PassageWay application is performing a task involving the
telephone (for example, while AT&TSet is reading your telephone’s
programming), the operation in progress will be aborted and must be restarted
manually once the initialization window disappears. If no task involving the
telephone is in progress during this process, the operation of PassageWay
applications is unaffected.

The chance of a communications problem depends on your PC’s configuration.
PassageWay operates at a data rate of 4800 baud, and it relies on Windows
to manage the flow of data through your PC’s serial port. Depending upon the
speed of your PC, the number and type of applications you are using, and
various hardware components in your PC configuration, Windows will be able
to manage serial communications with varying degrees of effectiveness.

If you encounter frequent communications errors using PassageWay Solution,
your PC’s current hardware configuration may not support reliable high-speed
communications under Windows. Appendix B includes information about
choosing serial port hardware that can work reliably at high speeds under
Windows.
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Troubleshooting AT&TCall

This section presents some common problems you might encounter using
AT&TCall For each problem, a strategy is presented that you can follow to
isolate and solve your problem.

Problem 1: AT&TCall does not dial or turn on the speaker

AT&TConnect must be running in order for AT&TCall to dial using your
telephone. Run AT&TConnect, wait for your telephone to be initialized, and try
dialing again.

If AT&TConnect will not run (that is, it displays the message "This application
requires a serial port" and then terminates) or if a communications error occurs
(that is, the Communications Error dialog box appears), refer to
"Troubleshooting AT&TConnect."

Problem 2: AT&TCall dials the wrong numbers

If AT&TCall dials telephone numbers incorrectly, perform the following steps to
isolate the problem:

1. Create a new card with a simple telephone number such as "777."

2. Add this card to the card bank.

3. Press the Dial button next to the telephone number and observe the
LCD display of your telephone. The PARTNER system will display each
digit dialed by PassageWay Solution on the telephone’s display.
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4.

5.

If the number dialed includes extra unexpected digits either before or
after the number, you probably have a dialing prefix and/or suffix
enabled for all cards in this bank. To disable an unwanted prefix or
suffix, select Dial Options from the Setup menu and select the
checkboxes to disable the prefix or suffix. Remember that prefixes and
suffixes apply to every number on every card in a given bank, so do not
make changes to them unless you wish these changes to apply to all of
the cards in the active bank.

If the number displayed on the screen did not have any extra digits
displayed before or after it, yet the call did not complete, or you reached
an incorrect number, your telephone may not be automatically selecting
the proper line or System Access button. In this case, consult with your
PARTNER System Manager and review the information in Chapter 2 to
insure that your telephone is set up correctly.

Problem 3: AT&TCall will not allow you to create a new card or edit an
existing card

Both the New Card and Edit Card buttons are disabled (as are a number of
menu items) whenever you are in the process of creating a new card or editing
an existing one. To restore the capabilities of these buttons, you must
complete the adding/editing operating already in progress and return the
new/edited card to the current card bank.

Note that the New Card and Edit Card windows can be minimized, so it is
possible that you may have minimized one of these windows previously and
have forgotten that you did so. If one of these windows was minimized, its icon
will appear in the icon area near the bottom of your Windows desktop. Simply
double-click on the icon to restore it to a window, then complete the add or
edit operation by choosing Add Card or Return Card. The New Card and Edit
Card buttons will then be restored.
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Troubleshooting

This section describes some common problems you might encounter while
using AT&TSet. For each problem, a strategy is presented that you can follow
to isolate and solve your problem.

Problem 1: AT&TSet does not permit you to program or read your
telephone

AT&TConnect must be running in order for AT&TSet to program and/or read
your telephone. If these options are disabled under the File menu, run
AT&TConnect. After your telephone has been initialized, these options will
become available to you.

If AT&TConnect will not run (that is, it displays the message "This application
requires a serial port" and then terminates), or if a communications error
occurs (that is, the Communications Error dialog box appears), refer to
"Troubleshooting AT&TConnect."

Problem 2: AT&TSet displays an error message after reading your
telephone

In order to read the information properly from your telephone, AT&TSet must
know the correct release number of your PARTNER system. If this parameter
is incorrect, AT&TSet will not be able to read your telephone properly. To
change this value, perform the following steps:

1. Close AT&TSet AT&TCall, and AT&TBuzz (if running). Also, if you have
any third party PassageWay applications running (that is, those written
by vendors other than AT&T), close them as well. Leave AT&TConnect
running.
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2. Double-click on the AT&TConnect icon to display its window, then select
Configure System. . . from AT&TConnect’s Setup menu. Note that
all PassageWay applications (other than AT&TConnect) must be closed
in order to select this option. If any applications are still running, this
option will be disabled.

3. Consulting the System Manager of your PARTNER system if necessary,
verify that the settings in this dialog box are correct for your PARTNER
system.

4. Run AT&TSet again. If AT&TSet failed to read your telephone’s
programming the first time it was run, it will automatically try to read it
now. If this happens, select the Cancel button on the status dialog box
that appears during the reading process, and select the OK button on
the message box indicating that the read operation was aborted by the
user.

5. Select Read from Telephone from AT&TSet’s File menu, and try to
read your telephone’s programming again. If an error message appears
after the reading operation is complete, try choosing the option from the
Telephone dialog box in the previous step (for example, if you originally
had "no" selected, try selecting "yes") and try again.
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Problem 3: AT&TSet gives you an error message while programming
your telephone (Attempt to replace feature X with feature Y
failed. . .)

This error occurs whenever AT&TSet attempts to program a particular feature
and the PARTNER system does not permit the operation to take place.
Generally, AT&TSet knows which operation the PARTNER system will permit
and which it will not, and you will generally not be able to select invalid
features for a given button. However, if your telephone’s programming has
been changed by any other means than using AT&TSet, it is possible that
AT&TSet’s image of your telephone’s programming has become outdated, and
operations which AT&TSet thinks are permissible based on its outdated image
may not be permissible when attempted on the telephone. For example, if your
System Manager may have added an extra line appearance to your telephone
using the PARTNER system’s Centralized Telephone programming
capabilities.

If this error occurs, you may continue programming your telephone or cancel
the programming operation altogether. In most cases, the safest thing to do is
to cancel the operation and then select Read from Telephone from the File
menu. This operation will refresh AT&TSet’s image of your telephone, which
should prevent programming problems in the future.
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Troubleshooting AT&TBuzz

This section describes some common problems you might encounter while
using AT&TBuzz. For each problem, a strategy is presented that you can
follow to isolate and solve your problem.

Problem 1: Your phone rings, but no call records appear in the
AT&TBuzz window

AT&TConnect must be running in order for AT&TBuzz to display records for
incoming calls. Run AT&TConnect.

If AT&TConnect will not run (that is, it displays the message "This application
requires a serial port" and then terminates) or if a communications error occurs
(that is, the Communications Error dialog box appears), refer to
"Troubleshooting AT&TConnect."

Problem 2: You pick up your handset to answer a call, but you do not
get the call you expected

You probably picked up your handset while the phone was inspecting the call.
To be sure, you should always answer from AT&TBuzz, and then switch to the
handset if desired.

Problem 3: AT&TBuzz automatically drops the active call when a second
call arrives

You probably selected the Auto-Drop First Call option in the Options dialog box
of AT&TBuzz. Verify the Answering Second Call setting in the Options dialog
box of AT&TBuzz.
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Problem 4: AT&TBuzz is running in Match to AT&TCall File mode and
you receive calls from numbers that are in the associated AT&TCall file,
but AT&TBuzz does not find any matches

Your area code is probably incorrect. Verify that your correct area code is
displayed in the Options dialog box.
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This appendix contains the menu trees for the PassageWay applications.
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Figure A-1. AT&TBuzz Menu Tree
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Figure A-2. AT&TCall Menu Tree
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Figure A-3. AT&TSet Menu Tree
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Figure A-4. Log Viewer Menu Tree
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Figure A-5. AT&TConnect Menu Tree
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Overview

This appendix provides detailed information about PC serial ports, including
background information about what they are and how they work, how Microsoft
Windows 3.1 manages them, how to resolve problems using COM3 or COM4
under Windows, and how to choose serial port hardware that is well-suited to
PassageWay Solution. If you are familiar with serial port terminology (for
example, I/O port addresses, IRQs, etc.), you may wish to skip over the
background section. If not, you should review the background section before
reading further.

If you are having problems using PassageWay Solution on COM3 or COM4,
you should refer to "Workarounds and Solutions to the IRQ Conflict Problem"
for advice on solutions and workarounds. If you intend to purchase an add-on
serial port card for use with PassageWay Solution, you should refer to
"Selecting an Add-In Serial Port Card" for information that can assist you in
selecting a card.
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Background

Serial ports (also sometimes referred to as communications ports or COM
ports) are hardware interfaces which permit your PC’s microprocessor to
communicate with peripheral devices using a communications standard called
RS-232 (hence, serial ports are also sometimes referred to as RS-232 ports).
Many common computer accessories make use of serial ports, including serial
mice, modems, serial printers, and the PassageWay adapter.

Under DOS (and Windows, which works cooperatively with DOS), the serial
port interfaces in a PC are uniquely identified by specific device names:
COM1 ("serial communications port 1"), COM2 ("serial communications port
2"), and so on, usually up through COM4. A particular PC might have none of
these devices, some of them, or all of them installed. For example, most PCs
currently on the market arrive from the manufacturer with two serial ports
already installed (COM1 and COM2), often integrated onto the computer's
main system board. Installing additional serial ports (for example, COM3 or
COM4) is usually accomplished by purchasing an add-on card and installing it
into a free expansion slot.

For most purposes (for example, configuring software), the generic description
of serial ports provided by their device names is sufficient. For example,
during the PassageWay Solution installation procedure, you are asked to
provide the device name of the serial port to which you have connected the
PassageWay adapter (for example, COM2). Unfortunately, this abstract view
of serial ports is not sufficient for other purposes, notably for troubleshooting
problems: to be able to do this effectively, a basic understanding of serial port
hardware is required. In particular, it’s essential to understand the mechanics
by which the computer’s microprocessor communicates with serial port
hardware.
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represents a small region of the microprocessor’s input/output memory space
which is used to pass data back and forth to the serial port. This memory
region acts something like a mailbox: outgoing mail (data from the
microprocessor to be transmitted to the peripheral device) is placed in the
mailbox by the owner (the microprocessor) to be picked up by the mail carrier
(the serial port hardware) for subsequent delivery to the destination party (the
peripheral device). In turn, the mail carrier (the serial port hardware) places
incoming mail (data from the peripheral device) into the box to be picked up by
the owner (the microprocessor). This analogy illustrates an additional
important point about I/O port addresses: just as individual mailboxes help the
residents in a neighborhood keep their mail from getting mixed up, each device
using an I/O port address to communicate with the microprocessor should
have a unique address that doesn’t conflict with that of any other device.

The mailbox analogy is also helpful in understanding the IRQ mechanism.
Normally, we place our outgoing mail in our mailbox at any convenient time
before the mail carrier arrives to pick it up. The outgoing mail sits in our
mailbox until the mail carrier arrives, at which time it is picked up and possibly
some incoming mail is placed in the mailbox. Then, sometime later, we check
our mailbox and retrieve our new incoming mail. The problem with this
scheme is that it’s not very efficient both the outgoing and incoming mail
spends some time just sitting in the mailbox. A better approach would be if the
mail carrier provided some sort of signal (for example, ringing the doorbell) to
announce his or her arrival, in which case we could hand over the outgoing
mail and pick up the incoming mail immediately. ln the PC architecture, IRQs
acts like the doorbell in our analogy they provide a method by which
hardware devices in the computer can get the microprocessor’s attention to
efficiently deal with some process. The serial port hardware makes use of an
IRQ to announce that it’s ready to receive more outgoing data and/or that new
data has arrived from the peripheral device which needs to be processed.

Like I/O port addresses, IRQs must generally be unique among the active
hardware devices in a computer system. In the mailbox analogy, the doorbell
is probably not a good signal since virtually anyone could ring the doorbell for
any number of reasons, not just to indicate the arrival of mail. Similarly, if a
particular IRQ signal is used (PCs generally support 16 unique IRQ signals,
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denoted IRQ0, IRQ1, and so on, up through IRQ15), the microprocessor must
take the appropriate action for the device associated with that IRQ. If there is
a mix-up, or if more than one device attempts to use the same IRQ at the
same time, a conflict occurs, and the outcome is often unpredictable and
usually undesirable (for example, the computer may "hang"). Because IRQs
are a limited resource, some newer PCs support IRQ sharing, a hardware
mechanism which permits more than one device to make use of the same
IRQ, but most PCs do not. For example, all PCs which use IBM’s
MicroChannel Architecture (MCA) support IRQ sharing, as do most PCs which
use the Enhanced Industry Standard Architecture (EISA) design. However,
most PC's in the marketplace - even new models - are based on the
traditional Industry Standard Architecture (ISA) which generally does not
support IRQ sharing.

The specific I/O port address and IRQ that a particular serial port uses is
determined by the hardware configuration of the serial port. Generally, these
parameters cannot be changed for built-in serial ports, but add-on cards
containing serial ports often provide jumpers or switches which can be used to
configure them to use one of several I/O port addresses and IRQ
combinations. The table below lists the default I/O port addresses and IRQs
used by the serial ports of IBM PC/AT-compatible computers:

Serial Port l/O Port Address IRQ
Device Name

COM1 03F8 4

COM2 02F8 3

COM3 03E8 4

COM4 02E8 3

The values in this table play an important part in understanding the "wrinkles"
associated with serial ports: although there is provision for up to four serial
ports, with four unique l/O addresses, there are only two unique IRQs
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associated with them (recall that most PCs require the IRQs used by each
active device to be unique to avoid conflicts). To understand why, it's useful
to recall what the PC world was like before the widespread availability of
products like Windows. When the architecture of the current generation of
PCs was first being designed (for the IBM PC/AT), the concept of multitasking
was not nearly as important in the PC marketplace as it is today.
Consequently, since DOS (before Windows) did not permit multiple
applications to run simultaneously (with the notable exception of certain
specialized programs such as mouse drivers), there was little need to provide
a mechanism by which several serial ports could be operated simultaneously.
Consequently, the strategy used was to conserve IRQs by assigning the same
IRQ to more than one COM port (that is, the COM1 and COM3 ports were
both assigned to IRQ4, and the COM2 and COM4 ports were both assigned to
IRQ3). Then, under the assumption that at most two serial ports would be
active simultaneously (for example, COM1 and COM2, which have unique
IRQs), conflicts would not occur.
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Serial Ports Under Windows 3.1

Unlike the DOS-only world of yesterday, today’s multitasking environments like
Windows permit the microprocessor to communicate with up to four active
serial port devices at the same time (COM1 through COM4). For example,
under Windows, if you are using a serial mouse (on COM1 ) within a terminal
emulator program which operates a data modem (on COM2), while using a fax
board (on COM3) to transmit or receive a fax "in the background," you are
using three serial port devices simultaneously. You might even wish to make a
phone call using PassageWay Solution (on COM4) at the same time, bringing
the total up to four simultaneously active serial port devices.

The fact that Windows permits this kind of powerful multitasking does not
guarantee that the underlying PC hardware can support this level of operation,
at least without some customizing at the hardware level. Since some PCs can
support it by default (for example, those which support IRQ sharing), Windows
doesn’t prohibit you from configuring your system and attempting tasks like the
one in the previous paragraph. Unfortunately, most PCs cannot support this
operation by default and the most likely result of attempting the above
scenario is "hanging" the PC due to an IRQ conflict. On such systems, using
COM1 along with COM2 is generally fine (recall that these devices have
unique IRQs by default), but the addition of COM3 or COM4 causes the
system to fail.

Fortunately, Windows 3.1 permits complete customization of all parameters
involving serial ports through the Control Panel, including configuring
nonstandard I/O port addresses and IRQs (that is, values different from those
in the table – these parameters can be viewed and/or modified by selecting
the desired port in the Control Panel’s "Ports" applet, selecting the "Settings..."
button, then selecting the "Advanced..." button). This flexibility offers the
opportunity of salvation for owners of PCs which do not support IRQ sharing
who require the use of three or more COM ports simultaneously.
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Workarounds and Solutions to the
IRQ Conflict Problem

It is important to remember that the IRQ conflict is a problem in hardware; it
cannot be resolved in software alone. Consequently, there are only three
alternatives for working around or resolving it:

Workaround 1: Configure your serial devices such that you use only two
at any one time, and those two use serial ports with unique IRQs.

This is the simplest workaround to the IRQ conflict problem, but it does not
solve the underlying conflict. The idea is to assign your peripheral devices to
your available serial ports in such a way as to avoid using any devices
simultaneously which might conflict. For example, if you have a serial mouse
on COM1 (IRQ4), a fax/modem card on COM2 (IRQ3), and your PassageWay
adapter on COM3 (IRQ4), you cannot effectively use PassageWay Solution
since you need to use your mouse under Windows while PassageWay
applications are running.

A better arrangement would be to move PassageWay Solution to COM4
(IRQ3), which could then be safely used with your mouse on COM1 (IRQ4). In
this case, the workaround is to avoid trying to use PassageWay Solution at the
same time you use the fax/modem on COM2, since the conflict now would be
over IRQ3 (COM2 and COM4).

Workaround 2: Replace one or more of your serial peripherals with
equivalent devices which do not require a serial port.

The idea with this approach is to eliminate the conflict by reducing the number
of peripherals in your system which require serial ports. For example,
replacing a serial mouse with a bus mouse (that is, a mouse which requires its
own add-in card) would make another serial port available that could then be
used by another device.
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Given the scenario described in item (1) above (that is, a mouse on COM1 a
fax/modem card on COM2, and PassageWay Solution on COM3), you might
buy a bus mouse and configure it to use, say, IRQ2 or IRQ5. This would then
permit you to move PassageWay Solution onto COM1 (IRQ4), where it could
then be used simultaneously with both the mouse and the fax/modem.

Likely candidates for conversion from a serial interface to some other interface
include mice (which can be converted to bus mice) and serial printers (which
can be converted to an additional parallel printer port).

Workaround 3: If your serial port hardware permits you to select IRQs
other than the default ones (IRQ3 and IRQ4), make use of one or more
unused IRQs in your system to assign each COM port a unique IRQ.

This solution is generally not possible for built-in serial ports since these are
usually "hard wired" and cannot be changed. Although most add-in cards
containing serial ports permit you to change the IRQs assigned to them, many
cards do not let you select IRQs other than IRQ3 and IRQ4. For example, an
internal modem card generally has jumpers or switches which permit you to
administer the serial interface on the card to be COM1, COM2, COM3, or
COM4, but the I/O port addresses and IRQs associated with each of these
configurations is usually fixed to the settings in the table.

Fortunately, some serial port add-in cards do permit you to select IRQs other
than 3 or 4 (the additional choices are often IRQ2 and IRQ5). If your serial
port hardware provides this flexibility – and at least one of the IRQ numbers
available as an option is currently unused in your PC setup – you can solve
the IRQ conflict directly.

For example, consider once again the scenario of a COM1 mouse, a COM2
fax/modem card, and a COM3 PassageWay Solution. If the COM3 serial port
is located on an add-in card which permits IRQs other than 3 or 4 to be
selected, you could configure the COM3 serial port to use a different
(available) IRQ in your system, say, IRQ5. After making the necessary
changes to the card (for example, adding or removing some jumpers or
adjusting the positions of some switches), the last step would be to configure

B-8



Appendix B: PC Serial Ports

Windows to monitor IRQ5 rather than IRQ4 for the COM3 serial port – this is
accomplished using the Windows Control Panel under the "Ports" option (see
your Windows documentation for details).

If you attempt this solution, you must be certain that you do not choose an IRQ
which is in use by some other device in your system – if so, you will only trade
one type of IRQ conflict for another. You should be aware that many common
add-in cards use IRQs, including network cards and multimedia sound cards,
both of which are commonly used under Windows. Your PC hardware vendor
can assist you in configuring IRQs. You may also need to consult the
documentation for your PC and any add-in cards which are installed to
determine which IRQs, if any, are available on your system.
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Selecting an Add-In Serial Port Card

This section presents advice on how to choose an add-in serial port card for
use with PassageWay Solution. Because PassageWay Solution does not have
any unique requirements with respect to serial ports, this advice applies
generically to selecting a serial port for use with any peripheral.

In general, there are two main things to consider when selecting a serial port
for use with PassageWay Solution:

1. Choose a card which offers the flexibility to configure its serial port IRQs
to values other than IRQ3 and IRQ4 (for example, to IRQ2 or IRQ5).

This capability often proves to be very beneficial, especially if you are
purchasing the card to add a COM3 and/or COM4 port to your system.
As described at length in "Workarounds and Solutions to the IRQ
Conflict Problem," for PCs which do not support IRQ sharing (which
includes most PCs, unfortunately), the ability to relocate the IRQ for
COM3 or COM4 away from the defaults (IRQ4 and IRQ3, respectively)
represents the only direct solution to conflicts which may arise when
attempting to use COM1 along with COM3 or COM2 along with COM4
under Windows.

If you know your PC does not support IRQ sharing, or if you are not
sure, it’s a good idea to purchase a card with this capability. If you
know your PC supports IRQ sharing, this capability is not as potentially
important.

2. For best performance with PassageWay Solution, choose a card which
has hardware support for high-speed communications.
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PassageWay Solution operates at a relatively high data rate (19.2 kbps,
or 19200 baud), and it relies on Windows to manage the flow of data
through your PC’s serial port. Depending upon your configuration,
Windows may have problems maintaining high data rates through
traditional serial ports. In these situations, a serial port designed for
high-speed communications can eliminate such problems while
providing a reduced load on the microprocessor (thus increasing the
performance of Windows during data transfers relative to standard serial
ports). In most cases, the price differential for such a card is quite
modest and a worthwhile investment

Many serial port cards on the market (and most built-in serial ports) use
either the 8250 or 16450 Universal Asynchronous Receiver Transmitter
(UART) as their key component. Although these UARTs can operate at
high speeds, they do not assist the PC’s microprocessor in dealing with
high-speed data transfer. Under Windows, in particular, data can be
lost at high baud rates using these UARTs. If this data loss occurs,
PassageWay Solution cannot function properly.

Whenever possible, select a serial port card which uses the 16550
UART. This industry standard UART is an improved version of the
16450 with hardware support to help offload the microprocessor during
high-speed data transfers. Windows 3.1 has built-in support for the
16550, so no special software configuration is required to obtain the
benefits of the 16550’s enhanced capabilities. In addition, any high-
speed peripheral can benefit from the 16550 (for example, a 9.6 kbps or
14.4 kbps data and/or fax modem), not only PassageWay Solution.

In generall, since there is no way of knowing ahead of time if your
particular PC configuration requires an enhanced serial port for
PassageWay Solution, AT&T strongly recommends that you purchase a
card based on the 16550 UART to insure trouble-free operation with
PassageWay Solution.
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Appendix C: Running AT&TBuzz
in Export via Paste Link DDE Mode

The Microsoft Windows operating system provides the Dynamic Data
Exchange (DDE) method for transferring data between applications. One form
of DDE supports a registered clipboard format called "Link." When associated
with the application’s Copy and Paste Link commands, the Link clipboard
format allows the user to establish DDE conversations between applications by
copying a data item in one application and paste linking it into the other.
AT&TBuzz running in Export via Paste Link DDE mode supports this method
for transferring call origin information to other Windows applications.

AT&TBuzz starts up the paste link operation when the user chooses to run in
Export via Paste Link DDE mode or when the user selects Initialize Paste Link
from the Setup menu in AT&TBuzz. This operation destroys the current
contents of the clipboard. The user must then do a Paste Link from the Edit
menu in the other Windows application. In most cases, the process to create
the link between the two applications will only have to be performed once.

After the link is created, AT&TBuzz will send a string of information to the other
application whenever a new Caller ID is received. The string contains four
fields. Each field is enclosed by quotation marks and separated from the other
fields by a comma and a space. The string has the following format:

"<handle>", "<caller id>", "<line Iabel>", "<call origin info>"
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where:

■ handle is an integer that refers to the handle of the telephone call.

■ caller id is the telephone number of the calling party.

■ line label is the label of the line that the call came in on.

■ call origin info is the complete call origin string. For PARTNER systems,
the call origin info is identical to the caller id.

A macro should be written in the other application to parse the string when it is
received. It may want to look up the caller id in its data base and display that
record. The macro governs what is done in that other application when new
Caller ID information is received.

The other application may also want to send information back to AT&TBuzz to
be displayed in the Call Label field of the call record list box. The application
will have to:

1. Initiate a DDE conversation with AT&TBuzz using the "Call_Label" topic.

2. Use the DDE Poke command to send the strings.

3. Terminate the conversation.

The string must be in the CF_TEXT clipboard format and look like this:
"<handle>", "<string of info.>"

where

■ handle is an integer that refers to the handle of the telephone call. This
number was passed to the application with the Caller ID and should be
passed back to AT&TBuzz so it knows to which call the string belongs.

■ string of info. can be anything the application would like AT&TBuzz to
display (for example, the name of the caller). The string can be up to
122 characters in length. If the string contains any quotation marks, they
should be doubled (for example, "James ""Jimmy"" Smith").

The Readme file has examples of macros in some common applications.
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Glossary

A

AT&TBuzz
Application that enables you to manage incoming calls (answer, hold, or drop)
and view Caller ID (when available) for each call appearing at your telephone.

AT&TCall
A card file application that enables you to maintain information such as names,
addresses, and telephone numbers.

AT&TConnect
Application that manages AT&TBuzz, AT&TCall, and AT&TSet and ensures
correct operation of the serial port to which your PassageWay Adapter is
connected.

AT&TSet
Extension programming application that enables you to program user features
and personal speed dial list for your MLS-34D, MLS-18D, or MLS-12D
telephone from your PC. If you are the System Manager, you can use
AT&TSet to perform Centralized Telephone Programming from your PC for any
telephone type (system or standard phones) and to program the system speed
dial list.

B

bank
The collection of cards in an AT&TCall file.

GL-1



Glossary

C

call log
A PassageWay file that stores an entry of every call you make from the Dial
buttons of a card or Quick Dials in an AT&TCall file, and incoming calls you
receive while AT&TBuzz is running.

call log archive file
A file in which you may store call log entries.  This is an ASCII file in which
each field of data is separated by a tab.

Caller ID
The call origination information that may be delivered with an incoming call.

card
A data record in an AT&TCall file. This record contains a maximum of 13 data
fields.

comma separated values format
A data file that contains records consisting of horizontal fields of data. Each
field of data is separated from the next field by a comma (,).

D

dialpad window
A window in AT&TCall that functions like the dialpad on your telephone.
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L

Log Viewer
An application that enables you to view call entries that are stored in the
PassageWay call log.

S

standard phones
Industry-standard single-line rotary or touch-tone telephones, including feature
phones with built-in feature buttons and lights.

system phone
AT&T telephones specifically designed to work with the PARTNER system.
These include the MLS-34D, MLS-18D, MLS-12D, MLS-12, MLS-6, and MLC-6
model telephones.
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A

account code options,
setting in an AT&TCall file, 4-55

always on top,
setting, 4-56

answering calls, 3-11
area code,

setting for AT&TBuzz, 3-17
AT&TBuzz,

accessing the Log Viewer, 3-11
always on top, 3-18
answering a call, 3-11
Caller ID messages, 3-7
changing the AT&TCall file associated

with AT&TBuzz, 3-13
creating a new card in the associated

AT&TCall file, 3-13
description, 3-2
exiting, 3-4
helpful hints, 3-10
menu options, 3-23
menu tree, A-2
resetting the size of the AT&TBuzz

window, 3-14
selecting a call record, 3-14
setting Auto-Hold, 3-15
setting for Auto-Drop, 3-15
setting AT&TBuzz to show the

associated card automatically, 3-16
setting the area code, 3-7

setting the AT&TBuzz window to
appear automatically, 3-17

setting Automatic Inspect mode, 3-18
setting the run mode, 3-19
setting AT&TBuzz to log incoming

calls, 3-20
showing cards of incoming calls on

demand, 3-21
tasks, 3-11
using the timer, 3-21

AT&TCall,
accessing the Log Viewer, 4-39
accessing the notes field, 4-60
accessing information for

a Quick Dial, 4-66
assigning a phone number to a

Quick Dial, 4-67
associating an AT&TCall file with

AT&TBuzz, 3-13
card tasks, 4-60
changing the field labels in cards, 4-60
changing the setup of the Quick Dial

labels, 4-69
changing the number of Quick Dials

displayed, 4-69
creating a template file, 4-40
creating a new file, 4-41
creating a new card, 4-61
deleting a card, 4-61
description, 4-2
dialing a phone number from a

Quick Dial, 4-71
editing an existing card, 4-63
entering telephone numbers

in a card, 4-64
erasing a Quick Dial, 4-71
exiting the application, 4-43

Index-i



Index

exporting information, 4-44
file tasks, 4-38
helpful hints, 4-37
hiding the card display, 4-65
importing files into AT&TCall, 4-45
making a call from the dialpad, 4-41
making a call from a card, 4-62
making a call from a Quick Dial, 4-71
menu descriptions, 4-73
menu tree, A-3
opening files, 4-48
printing a card list, 4-49
printing a card, 4-50
printing a file, 4-50
programming a phone number to a

Quick Dial, 4-67
removing a password, 4-54
re-assigning an existing

Quick Dial, 4-71
running the application, 4-38
saving a file, 4-55
selecting a card, 4-65
setting a password for a file, 4-53
setting the account code options, 4-55
setting window to always be

on top, 4-56
setting the dial options, 4-57
setting a file to be loaded

automatically, 4-58
showing the card display, 4-65
sorting cards in the bank, 4-39
tasks, 4-38
troubleshooting, 9-11
tutorial, 4-10
using the timer, 4-65

AT&TConnect,
accessing the events log, 7-4
changing the COM port, 7-6
changing the labels of the

line buttons, 7-8
description, 7-2
menu descriptions, 7-15
menu tree, A-6
programming a Caller ID Inspect

button, 7-11
running the application, 7-2
specifying the PARTNER system

version, 7-7
tasks, 7-4
testing the PassageWay adapter, 7-13
troubleshooting, 9-2

AT&TSet,
accessing the current programming

from your telephone, 5-31
changing the button labels, 5-12
converting a file to a different button

configuration, 5-13
creating a new file, 5-14
description, 5-2
exiting the application, 5-15
inspecting a button, 5-15
menu options, 5-44
menu tree, A-4
opening an existing file, 5-17
printing button labels, 5-18
programming a button, 5-21
programming your telephone, 5-28
running the application, 5-9
saving a file, 5-33
selecting buttons to be programmed to

your telephone, 5-35
tasks, 5-12
troubleshooting, 9-13, 9-16
writing a file to your telephone, 5-28

Index-ii



Index

autodialing applications,
helpful hints, 8-4
using with PassageWay, 8-1

Automatic Inspect mode,
setting, 3-18

Auto-Drop,
setting, 3-15

Auto-Hold,
setting, 3-15

B

button labels,
changing in AT&TSet, 5-12
printing in AT&TSet, 5-18

calls,
answering, 3-11
logging, 3-20

cards,
entering telephone numbers, 4-64
showing in AT&TBuzz, 3-21

COM port,
changing the COM port, 7-6

COM ports,
overview, B-1
verifying the number of active ports in

your system, 9-2
converting AT&TSet files, 4-13

D

C
dial option,

setting in AT&TCall, 4-57
dialpad,

making a call from, 4-41

call log,
deleting entries from, 6-6
description, 6-2
printing entries from, 6-8

call records,
selecting, 3-14

Caller ID,
description, 3-7
messages, 3-7

Caller ID Inspect button,
programming, 7-11

E

events log,
accessing, 7-4

exporting,
AT&TCall information, 4-44
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F

field labels,
changing in AT&TCall, 4-60

file tasks,
AT&TCall, 4-38

H

helpful hints,
AT&TBuzz, 3-10
AT&TCall, 4-37
autodialing applications, 8-4
Log Viewer, 6-5

I

importing,
AT&TCall, 4-45

Inspect button,
programming, 7-11

installation,
overview, 2-1

installing,
PassageWay software, 2-11
PassageWay adapter, 2-7

L

line buttons,
changing the labels, 7-8

Log Viewer,
accessing from AT&TBuzz, 3-11
accessing from the AT&TCall

application, 4-39
deleting entries from the call log, 6-6
description, 6-2
helpful hints, 6-5
menu descriptions, 6-14
menu tree, A-5
printing log entries, 6-8
running the application, 6-5
setting the preferences, 6-8
sorting call log entries, 6-10
specifying calls to be displayed, 6-12
tasks, 6-6

logging calls,
AT&TBuzz, 3-20

M

menu tree,
AT&TBuzz, A-2
AT&TCall, A-3
AT&TConnect, A-6
AT&TSet, A-4
Log Viewer, A-5
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notes,
accessing in AT&TCall, 4-60

P

PARTNER system,
specifying the version, 7-7

PassageWay,
components, 2-2
installation overview, 2-1
overview, 1-1
requirements, 2-5
user responsibilities, 1-3

PassageWay adapter,
installing, 2-7
testing, 7-13

PassageWay software,
installing, 2-11

password,
administering for an AT&TCall file, 4-53
removing from an AT&TCall file, 4-54

printing,
AT&TCall card list, 4-49
AT&TCall file, 4-50
AT&TCall card, 4-50
button labels in AT&TSet, 5-18

programming your telephone, 5-28

Q

Quick Dial,
accessing information about, 4-66
assigning a phone number to, 4-67
changing the number displayed, 4-69
changing the setup of the labels, 4-69
dialing a phone number from, 4-71
erasing, 4-71
making a call from, 4-71
programming a phone number to, 4-67
re-assigning an existing

Quick Dial, 4-71
tasks, 4-66

Index

R

run mode,
setting, 3-19

S

serial ports,
overview, B-1
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T

tasks,
AT&TBuzz, 3-11
AT&TCall, 4-38
card, 4-60
Log Viewer, 6-6
Quick Dial, 4-66

technical support, 1-4
timer,

using in AT&TBuzz, 3-21
using in AT&TCall, 4-65

W

writing a file to your telephone, 5-28
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